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 EasyBuilder Pro Installation 1.

and Startup Guide 
This chapter explains how to install EasyBuilder Pro. 

 

1.1. Installation Requirements............................................................................................. 1-2 

1.2. Steps to Install EasyBuilder Pro .................................................................................... 1-3 
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1.1. Installation Requirements 

Software: 

Vƛǎƛǘ ²ŜƛƴǘŜƪ [ŀōǎΣ LƴŎΦΩǎ ǿŜōǎƛǘŜ ŀǘ http://www.weintek.com and download the installation 

package which include the following languages: Simplified Chinese, Traditional Chinese, English, 

Japanese, German, Italian, Korean, Spanish, Russian, French, Polish, and Turkish. The latest 

updates can be downloaded too. 

 

Operating System: 

Windows® 7 SP1 (32bit / 64bit) 

Windows® 8 (32bit / 64bit) 

Windows® 8.1 (32bit / 64bit) 

Windows® 10 (32bit / 64bit) 

 

 

  

http://www.weintek.com/
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1.2. Steps to Install EasyBuilder Pro 

1. Click [Install] and select the language for the installation process, and then click [Next]. 

 

2. If there is a previous version of EasyBuilder Pro on the PC, please remove it before 

installation. 

3. Please read and accept the License Agreement before continuing. 
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4. Select a folder for EasyBuilder Pro installation, or use the default folder. Click [Next]. 

 

5. Select a start menu folder, or use the default folder. Click [Next]. 
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6. Select additional tasks, for example: [Create a desktop icon]. Click [Next]. 

 

7. Confirm all setting. To change the setting, click [Back]. To start installation, click [Install]. 
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8. Installation in progress. 

 

9. Click [Finish] to complete the installation. 
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10. The EasyBuilder shortcut can be found in [Start] » [All Programs] » [EasyBuilder Pro]. 

 

The description of each item in EasyBuilder Pro menu: 

Installed file Description 

Administrator Tools Saves User Accounts, USB Security Key, e-Mail SMTP 

Server Setting, e-Mail Contacts to an external device 

(USB drive or SD card) so that the data become 

portable and can be imported to HMI. 

cMT Viewer Supports access to cMT Series HMI via network, for 

operating cMT Series HMI on PC. 

Easy Access Supports access to remote HMI by connecting 

EasyAccess server over Internet. 

EasyBuilder Pro EasyBuilder Pro project editor. 

EasyConverter Conversion tool for Data Sampling and Event Log. 

EasyDiagnoser Monitoring and debugging tool operated on HMI. 

EasyPrinter Allows exporting data to a remote server on PC via 

Ethernet, realizing remote printing / backup. 

EasySimulator Executes simulation. 

EasySystemSetting Allows updating hardware system settings by using 

SD card or USB drive. 

EasyWatch An easy to use debugging and remote monitoring 
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tool running on PC that allows monitoring or setting 

HMI and PLC addresses and executing macro. 

Recipe Editor Tool for setting the format of Recipe data. Users can 

open Recipe data or the data in the External 

Memory. 

Release Note Software release notes. 

Utility ManagerEx EasyBuilder Pro management tool. 

Note 

Â Certain HMI supports downloading/uploading projects via USB cable. After installing  

EasyBuilder Pro, the USB driver will be automatically installed. A message saying 

άWindows canΩt verify the publisher of this driverέ may show, please continue anyway. 

After installing the USB driver, open [Computer Management] » [Device Manager] to 

check if installation succeeded.
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 Utility Manager 2.
This chapter explains how to use Utility Manager. 

 

 

2.1. Overview ....................................................................................................................... 2-2 

2.2. HMI IP, Password .......................................................................................................... 2-4 

2.3. Editing Tools .................................................................................................................. 2-5 

2.4. Transfer ......................................................................................................................... 2-6 

2.5. Simulation ..................................................................................................................... 2-8 

2.6. Pass-Through ................................................................................................................ 2-9 
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2.1. Overview 

After installing EasyBuilder Pro, double click [UtilityManagerEx] shortcut on the desktop to 

start. Utility Manager is for launching several utilities and it is a stand-alone program. 

 

Utilities Description 

Select Model Select your HMI model. Please note that if the model is incorrect, 

certain features may not work correctly. 

Design EasyBuilder Pro: Launch EasyBuilder Pro to edit projects. 

EasyAddressViewer: Review the address ranges and formats of 

supported PLCs. 

Simulation: Simulate a HMI on PC by On-line Simulation (with PLC) 

or Off-line Simulation (without PLC). 

Analysis & Testing EasyDiagnoser: On-line monitoring and debugging tool. Diagnose 

the connection status between PC/HMI and PLC. 

See ά33 EasyDiagnoserέ. 

EasyWatch: Allows users to monitor HMI or PLC address values via 

Ethernet on PC. 

See ά35 EasyWatchέ. 

Reboot HMI: Restart a HMI to its initial condition by Ethernet or 

USB connection. 

Pass-Through: Allows PC applications to control PLC via HMI. In this 

case the HMI is an adaptor. 
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See ά29 Pass-throughέ. 

Publish Download: Download project file to HMI via Ethernet or USB cable. 

Upload: Upload files on HMI to PC via Ethernet or USB cable. 

Build Download Data for SD/USB Disk: 

Build the data to be saved in SD card / USB drive and then insert 

the device to HMI to download the data. This feature is not 

supported by cMT Series. 

Maintenance EasyPrinter, Backup/Printer Server: A backup/printer server on PC, 

which receives backups from HMI and run a defined batch to 

convert, or HMI screenshots to print out on PC. 

Administrator Tools: Allows storing the data of [User Accounts], 

[USB Security Key], [e-Mail SMTP Server Settings], and [e-Mail 

Contacts] to USB. 

See ά36 Administrator Toolsέ. 

cMT Viewer: Connect to a cMT Series model. PC is the display 

terminal for cMT project. 

Data/Event log Information: Connect with HMI via USB cable or 

Ethernet to check the number of history files in HMI. This feature is 

not supported by cMT Series. 

EasyAccess 1.0: Control remote HMI instantly and conveniently no 

matter which corners in the world you are. You can find more 

information at: www.ihmi.net 

Data Conversion Database Editor: Used to edit recipe data. 

 Click the icon to download the document about Recipe 

Database. 

Easy Converter: Reads the data sampling file and event log file in 

HMI and convert the files to Excel (.xls) format. 

See ά25 EasyConverterέ. 

Recipe Editor: Used to create, view, and edit recipe data. 

See ά24 Recipe Editorέ. 

 Minimize the window. 

 Close the window. 

 
Add the frequently used utilities to the toolbar at the bottom of the 

window. 

Run Run the selected utility on the toolbar. 

Edit Delete the selected utility on the toolbar. 

ftp://ftp.weintek.com/eMT3000/eng/Document/New_Recipe_Functions.pdf
ftp://ftp.weintek.com/eMT3000/eng/Document/New_Recipe_Functions.pdf
http://www.ihmi.net/
ftp://ftp.weintek.com/eMT3000/eng/Document/New_Recipe_Functions.pdf
ftp://ftp.weintek.com/eMT3000/eng/Document/New_Recipe_Functions.pdf
ftp://ftp.weintek.com/eMT3000/eng/Document/New_Recipe_Functions.pdf
ftp://ftp.weintek.com/eMT3000/eng/Document/New_Recipe_Functions.pdf
ftp://ftp.weintek.com/eMT3000/eng/Document/New_Recipe_Functions.pdf
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2.2. HMI IP, Password 

Settings 

When operating HMI via Ethernet or USB cable, please set the password for HMI to protect 

against unauthorized access. 

 
Set the download password. To use masking password, select [Mask] check box. 

Note 

Â Please remember the password, otherwise, while restoring HMI default settings, the 

project files and data in HMI will be completely erased. 

Reboot HMI 

Reboot the HMI without unplugging. After reboot, the system returns to the initial state. Set 

the correct IP address when rebooting HMI via Ethernet. 

 

Data/Event Log File Information 

After setting, connect with HMI to check the number of history files in HMI. 
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2.3. Editing Tools 

 Build Download Data for SD/USB Disk 2.3.1.

 
1. Insert an external device (SD card or USB drive) to PC. 

2. Assign the directory to store data. 

3. Select the directory of the source file. 

4. Click [Build] to create files for downloading. 

Files will then be store to the inserted device for users to download to HMI without connecting 

via a USB cable or Ethernet. 

 Steps to Download Project to HMI via USB Disk or SD Card 2.3.2.

Assume we will download data in the folder named άмноέ όYΥ\123) on an USB disk. 

1. Insert USB (in which the project is saved) to HMI. 

2. In [Download / Upload] dialog box select [Download]. 

3. Enter Download Password. 

4. In [Download Settings] dialog box, select [Download project files] and [Download history 

files] check boxes. 

5. Press [OK]. 

6. In [Pick a Directory] dialog box, select directory: usbdisk\disk_a_1\123. 

7. Press [OK]. 

Project will then be updated. 
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Note 

Â If only the history files are downloaded, it is necessary to reboot HMI to update files. 

2.4. Transfer 

 Download (PC->HMI) 2.4.1.

Download files to HMI via Ethernet or USB cable. 

 

Setting Description 

Firmware Update HMI kernel programs. The firmware 

must be downloaded at the first time 

downloading data to HMI. 

MQTT If MQTT is used in the project and HMI is the 

broker, this checkbox must be selected before 

download. 

Project Select an .exob /  .cxob project file. 

RW / RW_A Select a .rcp recipe file. 

Recipe database Select a .db file of Recipe Database. 

System settings Select a conf. system settings file. 
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Startup screen Download a .bmp bitmap file to HMI. After HMI 

is rebooted, this .bmp file will be shown before 

project starts. 

Reboot HMI after 
download Automatically reboot after download. 

Port No. Setting Select the port by which to download the 

project file via Ethernet. 

Synchronize HMI clock 
with PC 

Synchronize HMI time with PC time when 

downloading project file. 

Reset recipe / recipe 
database / event log / 
data log / operation log 
/ string table / Delete 
startup screen / Delete 
existing user accounts, 
e-Mail contacts and 
SMTP settings 

Erase the selected files in HMI before download. 

 Upload (HMI->PC) 2.4.2.

Upload files from HMI to PC via Ethernet or USB cable. Click [Browse] and assign the file path 

before uploading. 

 

Setting Description 

Event log Upload the .evt file in HMI to PC. 



Utility Manager 

 

EasyBuilder Pro V6.04.01 

2-8 

Extended Memory 

(EM) 

Upload the .emi file saved in SD card or USB disk 

to PC. 

 For information about [Project], [RW / RW_A], [Recipe database] or [Data log], see ά2.4.1 

Downloadέ in this chapter. 

Note 

Â The file will be uploaded to PC in .exob / .cxob format. Please decompile it into 

editable .emtp file first and open the .emtp / .cmtp file in EasyBuilder Pro. 

Â To upload the historical files saved in the external device, please use FTP. See ά32 FTP 

Server Applicationέ for more information. 

2.5. Simulation 

 Off-line Simulation / On-line Simulation 2.5.1.

Off-line simulation: Simulate project operation on PC without any connection. 

On-line simulation: Simulate project operation on PC and PLCs are directly connected with PC. 

Note 

Â When using [On-line simulation] on PC, if the target device is a local PLC (the PLC directly 

connected to PC), there is a 10 minutes simulation limit. 

Before executing On-line/Off-line Simulation, please select the source .exob file. 

When executing On-line/Off-line Simulation, right click to use these functions: 

 

Setting Description 

Exit simulation Stop simulating. 

Run EasyDiagnoser To monitor current communication status. 

Screenshot Capture and save current screen image as a 

picture file in the screenshot folder under the 

installation directory. 

  



Utility Manager 

 

EasyBuilder Pro V6.04.01 

2-9 

2.6. Pass-Through 

This function allows the PC application to connect PLC via HMI. In this case, the HMI works like 

a converter. 

 

Pass-through provides two modes: [Ethernet] and [COM port].  

When using [Ethernet], please install the virtual serial port driver first. 

 

 FƻǊ ƳƻǊŜ ŘŜǘŀƛƭΣ ǇƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ά/ƘŀǇǘŜǊ нф tŀǎǎ-Through CǳƴŎǘƛƻƴέΦ 
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 Create an EasyBuilder Pro 3.

Project 
This chapter explains the basic steps to create an EasyBuilder Pro project. 

 

3.1. Overview ....................................................................................................................... 3-2 

3.2. Create a New Project File ............................................................................................. 3-2 

3.3. Save and Compile the Project File ................................................................................ 3-4 

3.4. Run On-Line or Off-Line Simulation .............................................................................. 3-5 

3.5. cMT Viewer ................................................................................................................... 3-5 

3.6. Download the Project File to HMI ................................................................................ 3-6 

3.7. Upload the Project File from HMI ............................................................................... 3-13 

 

  



Create an EasyBuilder Pro Project 

 

EasyBuilder Pro V6.04.01 

3-2 

3.1. Overview 

The following is the process of creating a project.  

1. Create a new project file. 

2. Save and compile the project file. 

3. Run On-line or Off-line simulation. 

4. Download the project file to HMI. 

The following describes each process. 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

3.2. Create a New Project File 

1. Launch EasyBuilder Pro and open a new project file. 

2. Select a model and select [Use template] check box. 

 
3. Click [New] button in the Device tab and select a device. 

https://www.youtube.com/watch?v=LU9At3ax2sc
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4. Configure parameters. 

 

5. A new device is added to the [Device List]. 

 

6. Create an object, for example, a Toggle Switch, and then set the address. 
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7. Place the object in the edit window. A project is now created. 

 

3.3. Save and Compile the Project File 

1. In EasyBuilder Pro toolbar click [File] » [Save] to save the .emtp file. 

2. In EasyBuilder Pro toolbar click [Project] » [Compile] to compile .emtp file as .exob file, 

which could be downloaded to HMI. This also checks if the project can run correctly. 
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Note 

Â For cMT Series models, the project file extension is .cmtp, and the compiled file extension 

is .cxob. 

3. To use multiple languages, all languages must be configured in Label Tag Library first. 

When downloading the project to HMI, select the needed languages only. A successful 

compilation is shown in the following figure. 

 

3.4. Run On-Line or Off-Line Simulation 

 Off-line simulation: Simulate project operation on PC without the need for connecting 

any device. 

 On-line simulation: Simulate project operation on PC without downloading the project 

to HMI. The PLC is connected to PC, please set correct parameters. 

Note 

Â When using On-line Simulation on PC, if the target device is the PLC directly connected to 

PC, there is a 10-minute simulation limit. 

3.5. cMT Viewer 

This program connects to cMT Series models via network. To run this program, execute 
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cMTViewer.exe under installation directory. Or, in EasyBuilder Pro toolbar, click [Tools] » [cMT 

Viewer]. 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

 

3.6. Download the Project File to HMI 

The following explains four ways to download the project file to HMI. 

Note 

Â For cMT-SVR, only the way described in 3.6.1 is available. 

Â When download project file to HMI using mini USB cable, please do not connect PLC 

simultaneously, in order to avoid noise from PLC interfering with HMI. 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

 Configure in EasyBuilder Pro  3.6.1.

1. In EasyBuilder Pro toolbar, click [Project] » [Download]. Make sure that all the settings are 

correct. 

2. Select [Ethernet], set password and HMI IP. 

https://www.youtube.com/watch?v=w3cEfnMk8Fo
https://www.youtube.com/watch?v=SgTe_SJ_l08


Create an EasyBuilder Pro Project 

 

EasyBuilder Pro V6.04.01 

3-7 

 

Setting Description 

Font files Download the font used in the project to HMI. 

Runtime Select the check box to update the HMI kernel 

programs. If this is the first time downloading file or 

EasyBuilder Pro version is updated, please download 

the firmware before downloading files to HMI. 

EasyAccess 2.0 Download EasyAccess 2.0 driver to HMI. (This option 

is available only for MT8000iE models. For other 

models, EasyAccess 2.0 will be automatically 

downloaded.) 

Use user-defined 
startup screen 

Download the selected .bmp picture to HMI as the 

startup screen. 

Use system settings 
file 

Download the system settings file to update 

hardware settings. 

Synchronize HMI 
clock with PC 

Synchronize HMI time with PC time when 

downloading project file. 

Delete existing user 
accounts, e-Mail 
contacts and SMTP 
settings 

Select the check box to delete existing user 

accounts, e-Mail contacts or SMTP settings before 

downloading the project. This setting is only 
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effective when one of the following settings is 

enabled:  

1. [System Parameters] » [Security] » [Enhanced 

security mode] » [Use existing user accounts on 

HMI first (if existed), Othrewise, use settings 

below]. 

2. [System Parameter s] » [e-Mail] » [Use existing 

user accounts on HMI first (if existed), 

Othrewise, use settings below]. 

Reset recipe/ 
event log/ 
data sampling/ 
recipe database/ 
operation log/ 
string table/ 
user-defined 
startup screen 

The selected files will be erased before 

downloading. 

Reboot HMI after 
download 

HMI will reboot after the downloading process is 

done. 

Automatically 
using current 
settings to 
download after 
compiling 

The system will compile the project and download it 

to the latest target HMI. The way to enable this 

function is described in the following part. 

 

[Automatically using current settings to download after compiling] 

If this check box is selected, EasyBuilder Pro will compile the project and download it to the 

latest target HMI. 

1. In EasyBuilder Pro toolbar, click [File] » [Preferences]. 

2. Select [Automatic save and compile when download and simulate] check box. 
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3. In EasyBuilder Pro toolbar, click [Save] and then [Download]. 

4. In the dialog box, select [Automatically using current settings to download after compiling] 

check box. 

5. Click [Download]. 

6. When finished, next time when [Download] is clicked, EasyBuilder Pro will automatically 

compile and download the project to the latest target HMI. 

 Use HMI Name 3.6.2.

1. Go to [System settings] on HMI and then set HMI name first. 
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2. On PC, select the HMI name and start downloading. To use [Search], enter the HMI name 

first to search for the HMI. [Search all] searches for all HMIs in the same subnet network. 
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 Use USB cable 3.6.3.

 

Select USB cable to download project to HMI. The way of setting is same as ά3.6.1 Configure in 

EasyBuilder Proέ. Before downloading via USB cable, please make sure the USB driver is 

installed. Go to [Computer Management] » [Device Manager] to check if USB driver is installed. 

If it is not installed, please refer to installation steps to install manually. 

 Use USB Drive or SD Card 3.6.4.

The following explains how to download project file by using USB drive or SD card. 

1. On EasyBuilder Pro toolbar click [Project] » [Build for SD card / USB disk download]. 

Browse for the project file and then click [Build], the file for download will be generated in 

the connected external device. 

ftp://ftp.weintek.com/MT8000/eng/FAQ/FAQ_29_How_to_install_USB_driver_of_HMI_i_series.pdf
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2. Insert an external device to HMI. 

3. Select [Download] on HMI and enter password. 

 

4. After password is confirmed, it will show the directories in the external device. (pccard: SD 

Card; usbdisk: USB Drive) 

 

5. Select the directory that contains project, and then click [OK] to start downloading. 



Create an EasyBuilder Pro Project 

 

EasyBuilder Pro V6.04.01 

3-13 

Note 

Â Please select the parent directory of the generated files when downloading. For the 

structure above, please select disk_a_1, not mt8000ie. 

Â You may click [System Settings] to save the hardware settings configured in EasyBuilder 

Pro into SD card or USB disk, and then download the settings file to HMI. See ά4 Hardware 

Settingsέ for more information. 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

3.7. Upload the Project File from HMI 

1. On EasyBuilder Pro toolbar click [File] » [Upload]. 

2. Set HMI IP, HMI model, project location and project name, and then click [Upload]. 

 

 

https://www.youtube.com/watch?v=hV_EamYnN3U
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 Hardware Settings 4.
This chapter explains HMI settings. 

4.1. Overview ....................................................................................................................... 4-2 

4.2. I/O Ports ........................................................................................................................ 4-2 
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4.5. System Toolbar .............................................................................................................. 4-4 

 

  



Hardware Settings 

 

EasyBuilder Pro V6.04.01 

4-2 

4.1. Overview 

This chapter discusses the HMI settings. 

4.2. I/O Ports 

The I/O ports may vary between models; please see the datasheet for more information. 

The I/O Ports include: 

 ̧ SD card slot: Allows downloading / uploading project file, including recipe data, event log, 

data lƻƎΧŜǘŎ and also allows recording history data and data backup. 

 ̧ COM Port: Connects PLC or other peripheral devices. The type of serial port include: 

RS-232, RS-485 2W, RS-485 4W, and CAN Bus. 

 ̧ Ethernet: Allows downloading / uploading project file, including recipe data, event log, 

data lƻƎΧŜǘŎ. Connects to Ethernet devices, such as PLC, laptop. 

 ̧ USB Host: Supports USB devices, such as mouse, keyboard, USB disk, printer, or barcode 

device. 

 ̧ USB Client: Allows downloading / uploading project file, including recipe data, event log, 

data lƻƎΧŜǘŎ and also allows recording history data and data backup. 

 

For the first time operating HMI, please complete the following system settings. When finished, 

the project files designed using EasyBuilder Pro can be used on HMI. 

4.3. LED Indicators 

The LED indicators on the HMI indicate: 

Models: MT8121XE, MT8150XE, MT8121iE, MT8150iE 

LED Description 

PWR (Orange) Indicates power status. 

CPU (Green) Blinks when read/write Flash Memory. 

COM (Blue) Indicates COM port communication status, blinks 

during communication. When communication is 

good, it may stay on. (Not including network 

communication) 

Other Models: 

LED Description 

PWR (Orange) Indicates power status. 

CPU (Green) Indicates CPU status. If it blinks or goes out, there 



Hardware Settings 

 

EasyBuilder Pro V6.04.01 

4-3 

may be a CPU error. 

COM (Blue/Red) Indicates communication status, blinks during 

communication. When communication is good, it 

may stay on. 

4.4. System Reset 

Certain HMI models are equipped with a reset button and a set of DIP switches. When using 

the DIP switches to change modes, the corresponding functions will be triggered. If system 

password is lost or forgotten, see the following steps to restore factory default. 

1. Flip DIP Switch 1 to ON and the rest to OFF, and then reboot HMI. HMI will switch to touch 

screen calibration mode. 

2. A ά+έ sign appears on the screen, touch the center of the sign, after all 5 signs are touched, 

ά+έ disappears and the touch screen parameters will be stored in HMI system. 

3. After calibration, confirm to restore the default password, select [Yes]. 

4. Confirm to restore the default password again by typing [yes] and clicking [OK]. The 

project files and history records stored in HMI will all be removed. (The default Local 

Password is 111111. However, other passwords, such as Download/Upload passwords 

have to be reset.) 

 

The following lists the DIP switch settings of different models. Please see the relevant 

installation instruction. 

 

eMT / iE 

 
 

 

Note 

Â The state of DIP Switch 4 on each unit may be different. If it should be ON when out from 

factory, the Dip Switch 4 would be set ON and cut off. If it should be OFF, the Dip Switch 4 

would be set OFF but the switch is not cut. 

SW1 SW2 SW3 SW4 Mode 

ON OFF OFF OFF Touch Screen Calibration Mode 

OFF ON OFF OFF Hide HMI System Setting Bar 

OFF OFF ON OFF Boot Loader Mode 

OFF OFF OFF ON Reserved 

OFF OFF OFF OFF Normal 

SW1 SW2 Mode 

ON ON Restore factory default 

ON OFF Hide system setting bar  
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mTV 

 
 

cMT-SVR 

 
 

4.5. System Toolbar 

After rebooting HMI, you can set the system with [System Toolbar] at the bottom of the screen. 

Normally, this bar is hidden automatically. Only by touching the arrow icon at the bottom-right 

corner of the screen will the System Toolbar pop up. From left to right the icons are: System 

Settings, System Information, Text Keyboard, and Number Keyboard. 

 
How to hide HMI System Setting Toolbar: 

 ̧ When [DIP Switch 2] is set ON, the system setting toolbar is disabled. When set OFF; the 

system setting toolbar is enabled. Please restart HMI to enable/disable the toolbar. 

 ̧ For mTV Series, flip DIP Switch 1 to ON to hide system setting toolbar.  

 ̧ System register [LB-9020] can also enable/disable system setting toolbar. When [LB-9020] 

is set ON, the toolbar is displayed, and set OFF to hide the toolbar. 

 System Setting 4.5.1.

Set or modify system parameters. Confirm password for security first. The factory default 

password is 111111. 

OFF ON Boot loader mode  

OFF OFF Normal mode 

SW1 SW2 Mode 

ON ON Restore factory default 

ON OFF Restore Ethernet IP Settings 

OFF ON Boot loader mode  

OFF OFF Normal mode 
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Network 

When downloading project file to HMI via Ethernet, 

set the correct IP of the target HMI. You can obtain 

an IP address automatically or enter the IP address 

manually. To use Email and EasyAccess2.0, please set 

correct DNS address.  

 

Time / Date 

Set HMI local time and date. 

 

Security 

Password protection, the default is 111111. Please 

click the buttons to set the passwords, and finish 

password confirmation. 

[Password for entering system]  

[Password for uploading project] 

[Password for downloading project] 

[Password for uploading history data] 

 

History 

Clears history data in HMI. 
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HMI name 

Set HMI name to be used when download/upload 

project. 

 

OS setting 

[Upgrade OS] 

Upgrade firmware. Please do not turn off or unplug 

HMI during OS upgrade process. For more details, 

see the instruction about OS upgrade of the model 

used. 

[Portrait Mode] 

Set screen orientation mode. After changing the 

mode, reconnect HMI to power supply, for the 

setting to take effect. That is, disconnect all power 

from HMI, and then connect again. If portrait mode 

is used (90 or 270 degree), the project must be 

designed for portrait mode, otherwise it cannot be 

correctly displayed. 

 

 

VNC server setting 

Remote HMI monitoring and controlling via 

Ethernet. 

[Start VNC single-connection] 

Allows connection with one VNC client. 

[Start VNC multi-connection] 

Allows connection with multiple VNC clients. 

Connecting more VNC clients may slow down the 

communication speed. 

Please see the settings steps in the later part. 

 Click the icon to watch the demonstration film. 

Please confirm your internet connection before 

playing the film. 

https://www.youtube.com/watch?v=kRL3cxxHGkU
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Misc 1 

Rotary switch for adjusting LCD brightness. 

[Popup download window] 

If selected, after inserting USB disk or SD card to 

HMI, the Upload / Download dialog box shows. 

[Restart after download/upload] 

If selected, restarts HMI automatically after 

uploading / downloading project. 

 

Misc 2 

[Hide mouse cursor] 

If selected, the mouse cursor will be hidden. 

[Enable [Reset HMI to default] button in calibration 

mode] 

If selected, when the operator presses and holds 

anywhere on the screen for more than 2 seconds 

during HMI startup, the touch screen calibration 

mode will start. After calibration, [Reset HMI to 

default] option shows. 

[FTP client can modify USB/SD data] 

If selected, USB/SD data can be modified using FTP. 

[Modify HMI ports]  

Change the port number for Upload/Download and 

FTP. 

 

EasyAccess 2.0 

Activate EasyAccess 2.0 service. 

 Click the icon to download the demo project. 

Please confirm your internet connection before 

downloading the demo project. 

 

The following steps explain how to set VNC server. 

1. Enable HMI VNC server, set password. 

2. Install Java IE or VNC Viewer on PC. 

3. Enter remote HMI IP in Internet Browser. Or, in VNC Viewer enter remote HMI IP and 

password. 

https://dl.weintek.com/public/EasyAccess20/Project/EasyAccess_2_Demo.zip
https://dl.weintek.com/public/EasyAccess20/Project/EasyAccess_2_Demo.zip
https://dl.weintek.com/public/EasyAccess20/Project/EasyAccess_2_Demo.zip
https://dl.weintek.com/public/EasyAccess20/Project/EasyAccess_2_Demo.zip
https://dl.weintek.com/public/EasyAccess20/Project/EasyAccess_2_Demo.zip
https://dl.weintek.com/public/EasyAccess20/Project/EasyAccess_2_Demo.zip
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 System Information 4.5.2.

Network: Displays network information & HMI IP address. 

 

Version: Displays HMI firmware version and model type. 
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 System Parameter Settings 5.
This chapter introduces the system parameter settings. 
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5.1. Overview 

Launch EasyBuilder Pro, in the main menu select [Home] » [System Parameters] to open the 

[System Parameter Settings] dialog box. System Parameter Settings are divided into several 

tabs, these tabs will be introduced respectively in this chapter. 

5.2. Device 

Parameters in this tab determine the attributes of each device connected with HMI. The device 

can be a Local / Remote HMI / PLC. A default device "Local HMI" exists when creating a new 

project. This device is the HMI that will be updated and programmed. 

 How to Control a Local PLC 5.2.1.

 

άLocal Deviceέ is a device connected to the local HMI. To control/connect a Local Device, add 

this type of device first. Click [System Parameters] » [New] to open [Device Properties] dialog 

box. For example, when connecting MODBUS RTU as a Local Device: 
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Setting Description 

Name The name of the device. 

HMI /  Device In this example a device is used, so select [Device]. 

Location Select [Local] or [Remote]. In this example the device is 

connected to the Local HMI, so select [Local]. 

Device type Select the type of the device. 

I/F The available interface: [RS-232], [RS-485 2W], [RS-485 

4W], [Ethernet], [USB], and [CAN Bus]. 

 ̧ If the interface used is [RS-232], [RS-485 2W], or 

[RS-485 4W], configure communication parameters 

by clicking [Device Properties] » [Settings] and then 

[Com Port Settings] dialog box opens. 

 
Timeout 

If the communication has been disconnected for more 

than preset time limit configured in [Timeout] (in sec), 

Window No. 5 will pop up and show άDevice No 

wŜǎǇƻƴǎŜέ message. 

Turn around delay 

While sending the next command to the device, HMI will 

delay the sending according to the time interval set in 

[Turn around delay]. This may influence the efficiency of 

the communication between HMI and the device. Default 

value is άлέΦ 

Note: If the device used is SIEMENS S7-200 Series, it is 

recommended to assign ά5έ to [Turn around delay] and 

ά30έ to [Send ACK delay]. 

 ̧ If the interface used is [Ethernet], click [Device 

Properties] » [Settings] and the [IP Address Settings] 

dialog box opens. Please set correct device IP address 

and port number. 
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 ̧ If the interface is [USB], no further setting is 

required. Please check the settings in [Device 

Properties]. 

 ̧ If the interface is [CAN (Controller Area Network) 

Bus], please see άDevice Connection Guideέ for 

άCANopenέ and import the .eds device file. 

Device 

default 

station no. 

Set the default station number for device address if the 

device station number is not included in the address. 

Device station no. can be set in its address. The address 

format: ABC#Addr 

ABC stands for device station number and ranges from 0 to 

255. Addr stands for device address. And the άІέ sign 

separates the station number and the address. As shown 

in the following figure, the data is read from device station 

number 1, and address 0x-20. 

 

Default 
station no. 
use station 
no. variable 

Use the station number variables as the default device 

station number. Select one from LW-10000 to LW-10015 

(var0 to var15) as the station number variables. If the 
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station no. is not specified in device address, the station 

number will be determined by the station no. variable.  

For example, if var3 is set for default station no: 

 

The followings demonstrate some examples: 

 ̧ The device ǎǘŀǘƛƻƴ ƴǳƳōŜǊ ƛǎ άрέΦ 

 

 ̧ The device station number is determined by var7 

(LW-10007) 

 

 ̧ Device ŀŘŘǊŜǎǎ ƛǎ ǎŜǘ ǘƻ άмммέΣ ǎƛƴŎŜ device station 

no. is not specified, and the default station no. is 

var3, the device station no. is determined by var3 

(LW-10003). 

 

 Click the icon to download the demo project. Please 

confirm your internet connection before downloading the 

demo project. 

Use 

broadcast 

command 

When [Use broadcast command] check box is selected, 

please fill in [Broadcast station no.] according to the 

broadcast station number defined by the device. When 

HMI sends a broadcast command to the station number 

set here, the device will only receive the command and 

not reply to HMI. 

 

As shown in the following figure: 

https://dl.weintek.com/public/MT8000/Project/System_Sample/Station_Variable.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Station_Variable.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Station_Variable.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Station_Variable.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Station_Variable.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Station_Variable.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Station_Variable.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Station_Variable.zip
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When HMI sends a command to address 255#200, all the 

devices will receive this command and will not reply. 

Only devices that support broadcast command can use 

this feature. 

Interval of 

block pack 

(words) 

If the interval between read addresses of different 

commands is less than this value, the commands can be 

combined to one. The combining function is disabled if 

this value is set to άлέΦ 

For example, the interval value is set to άрέ, to read 1 word 

from LW-3 and 2 words from LW-6 respectively (read from 

LW-6 to LW-7), since the interval of addresses between 

LW-3 and LW-6 is less than 5, these two commands can be 

combined to one. The result is to read 5 consecutive words 

from LW-3 to LW-7. 

Note: The maximum size of command combination data 

must be less than [Max. read-command size]. 

Max. read -  
command 
size (words) 

The maximum data size to read from the device at one 

time. Unit: word 

Max. write - 
command 
size (words) 

The maximum data size to write to the device at one time. 

Unit: word. 

!ŦǘŜǊ ŀƭƭ ǎŜǘǘƛƴƎǎ ŀǊŜ ŎƻƳǇƭŜǘŜŘΣ ŀ ƴŜǿ ŘŜǾƛŎŜ ƴŀƳŜŘ ά[ƻŎŀƭ t[/ мέ ƛǎ ŀŘŘŜŘ ǘƻ ǘƘŜ ώ5ŜǾƛŎŜ ƭƛǎǘϐΦ 

 

Note 

Â When using cMT, select άLocal HMIέ in [System Parameter Settings] dialog box and then 

click [New Device] to add a άLocal PLC 1έ under άLocal HMIέ. 
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 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

 How to Control a Remote Device 5.2.2.

 
άRemote Deviceέ is a device being connected to a remote HMI. To control a remote device, add 

this type of device first. Please click [System Parameters] » [New] to open [Device Properties] 

dialog box. For example, use MODBUS RTU as the Remote Device: 

  

 

https://www.youtube.com/watch?v=jU1ky72WdoE
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Setting Description 

HMI or 

Device 
In this example, a device is used, so select [Device]. 

Location Select [Local] or [Remote]. In this example the device is 

connected to Remote HMI, so select [Remote]. Set the IP 

address and port number of the Remote HMI by clicking 

[Settings] next to [Remote]. 

 

Device Type Select the type of the device. 

I/F The interface used for Remote Device. If the remote device 

uses a COM port, select [RS-232], [RS-485 2W], or [RS485 

4W]. 

COM Set the correct COM port used by the Remote Device. 

Device 

default 

station no. 

Set the station number of Remote Device. 

 

!ŦǘŜǊ ŀƭƭ ǎŜǘǘƛƴƎǎ ŀǊŜ ŎƻƳǇƭŜǘŜŘΣ ŀ ƴŜǿ ŘŜǾƛŎŜ ƴŀƳŜŘ άwŜƳƻǘŜ t[/ 1έ ƛǎ ŀŘŘŜŘ ǘƻ ǘƘŜ ώ5ŜǾƛŎŜ 

list]. 

 

Note 

Â When using a cMT Series model, select the defined άRemote HMI 1έ in [System 

Parameters] dialog box and then click [New Device] to add a άRemote PLC 1έ under 

άRemote HMI 1έ. 
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 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

 How to Control a Remote HMI 5.2.3.

 
άRŜƳƻǘŜ IaLέ is the HMI other than άLocal HMIέ, and PC is also a άRemote HMIέΦ To control a 

Remote HMI, add this type of device first. Click [System Parameters] » [New] to open [Device 

Properties] dialog box as shown in the following figure: 

 

Setting Description 

HMI or 

Device 
In this example, the device used is a HMI, so select [HMI]. 

Location Select [Local] or [Remote]. In this example Remote HMI is 

used, select [Remote]. Set the IP address and port number 

of the Remote HMI by clicking [Device Properties] » 

[Location] » [Settings]. 

 

 

!ŦǘŜǊ ŀƭƭ ǎŜǘǘƛƴƎǎ ŀǊŜ ŎƻƳǇƭŜǘŜŘΣ ŀ ƴŜǿ ŘŜǾƛŎŜ ƴŀƳŜŘ άRemote HMI 1έ is added to the [Device 

list]. 

https://www.youtube.com/watch?v=pdsgKOlBmew
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Note 

Â When using a cMT Series model, in [Device list] click [New HMI] to add a άRemote HMI 1έ. 

 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

  

https://www.youtube.com/watch?v=pdsgKOlBmew
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5.3. Model 

Configure the [HMI model], [Timer], [Printer] and [Scroll bar] settings, and more. 

eMT̡ iE̡ XE̡ mTV Series 

  
cMT Series 
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Setting Description 

HMI model Select an HMI model. 

The [Resize pop-up windows /  objects] dialog box will pop 

up when changing to a model with a different resolution. 

Select required adjustment and click [OK]. In most cases, 

select all options. 

 

Landscape/Portrait 

Change the orientation of the project. 

HMI station no. Set the station number of current HMI. The default value is 

ά0έΦ 

Port no. Set the port number of current HMI. The default value is 

ά8000έ. 
Support cMT 
communication 
protocol 

Supports communication with cMT Series models. cMT 

Series project file should use the same communication port.  

Timer Clock source 

Set the source device of the clock/time information. It is 

used by [Data Sampling], [Event Log], etc. 

 ̧ If [HMI RTC] is selected, the time information comes 

from the internal clock of the HMI. 

 ̧ If [External device] is selected, the time information 

comes from an external device. The address of the 

source device must set correctly. As shown below, the 

time ƛƴŦƻǊƳŀǘƛƻƴ ƛǎ ŦǊƻƳ ά¢±έ address type of the 

ά[ƻŎŀƭ t[/έΦ ¢ƘŜ ŀŘŘǊŜǎǎes of ά¢±έ ǎǘŀǊǘ ŦǊƻƳ л and 

contain 6 consecutive words and each of them store 

the following information: 

TV 0 Ҧ  {ŜŎƻƴŘ (range: 0~59) 
TV 1 Ҧ  aƛƴǳǘŜ (range: 0~59) 
TV 2 Ҧ  IƻǳǊ όǊŀƴƎŜΥ лϤноύ 
TV 3 Ҧ  5ŀȅ όǊŀƴƎŜΥ мϤомύ 
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TV 4 Ҧ  aƻƴǘƘ όǊŀƴƎŜΥ мϤмнύ 

TV 5 Ҧ  ¸ŜŀǊ όǊŀƴƎŜΥ мфтлϤнлотύ 

 

 

Printer (eMT, 

iE, XE, mTV) 

Type 

A printer can be connected with the HMI. The HP PCL Series 

printer is connected through USB interface while other 

printers through a COM port. 

 For more information, see ά23 HMI Supported 

Printersέ. 

If the printer is connected through [COM], configure the 

parameters correctly. If the printer type is [SP-M, D, E, F], 

the [pixels of width] has to be set accurately, i.e. the set 

ǇƛȄŜƭόǎύ Ŏŀƴƴƻǘ ŜȄŎŜŜŘ ǇǊƛƴǘŜǊΩǎ ŘŜŦŀǳƭǘ ǎŜǘǘƛƴƎ, or the HMI 

will fail to print data. 

Printer (cMT 

Series) 

The printer driver can be installed on HMI. 

Type 

Select printer type. 

Status address 

Shows printer status. 
LW-n Status 
0 Printer driver is not installed yet. 
1 Installing printer driver. 
2 Printer is ready. 
3 Printer is printing. 
4 Print job is canceled. 
LW-n+1 Error 
0 None 
1 Printer is not found. 
2 Unknown error. 

Control address 
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Updates printer connection parameters. 

LW-n Command 
0 None 
1 Update connection parameters. 
2 Restart printer driver. 
LW-n+1 I/O 
0 Ethernet 
1 USB 
LW-n+2 IP address (Total: 4 words) 
LW-n+6 Port (Default port number: 9100) 

Please note that using only the ppd file for a printer may 

not be able to run the printer since the corresponding 

driver is absent. Using tested models is recommended. 

Scroll bar Set the width of Scroll Bar, when the size of the object is too 

small to display the contents, a scroll bar is displayed in the 

object. This feature can be applied to objects that allow 

scrolling, such as Alarm Display, Event Display, History Data 

Display, and Option List. 

Pass through 

(Virtual COM 

port) 

Set the port number for Pass-through communication. 

5.4. General 

Configure the properties related to screen display. 

eMT, iE, XE, mTV Series 
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cMT Series 
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Setting Description 

Options Enable fast display mode when change window 

With this option selected, certain objects will cache the 

most recent value and display it after changing window, to 

achieve fast display. 

The objects are: Bit Lamp, Word Lamp, Numeric, ASCII, Bar 

Graph, Meter Display, Animation, and Moving ShapeΧetc.  

RW_A enabled 

Enable or disable recipe data RW_A. Enable this, the 

objects can then control RW_A .The size of RW_A is 64K. 

Trigger release action anyway if touch moves out of the 

button. (cMT Series) 

With this option selected, releasing the finger after 

touching the button and then sliding the finger out of the 

button area is still considered as button release; its release 

action(s) will be triggered. 

Set value when leaving focus 

With this option selected, values will be written upon 

leaving the input mode of an object (e.g. Numeric object), 

even if not by pressing the ENTER key. For example,data 

entry for the current numerical object is considered 

completed and value is written when one selects another 

object to enter value. An alert message shows when an 

invalid value is entered. 

Windows Startup window no. 

Designate the window shown when start up HMI. 

Common window 

The objects in the common window (Window No. 4) will be 

shown in each base window. This determines that the 

objects in common window are placed above or below the 

objects in the base window. 

Object layout 

If [Control] mode is selected, when operating HMI, 

[Animation] and [Moving Shape] objects will be displayed 

above other kinds of objects neglecting the sequence that 

the objects are created. If [Nature] mode is selected, the 

display will follow the sequence that the objects are 

created, the first created will be displayed first. 

Enable window layers (This can be used to 

organize/show/hide objects) 

With this option selected, layers within a window can be 

created in the window tree.   
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At most 10 layers can be added to a window.  

As shown in the following rigure, right-click on a window 

number and then select [Add layer]. 

 

The following is an example of creating a layered window: 

Place a Bit Lamp object in Layer 1 and a Numeric object in 

layer 2. 

 

Selecting Layer 1 shows only the Bit Lamp object in the 

editing window. 

 

Selecting Layer 2 shows only the Numeric object in the 

editing window. 
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Selecting window 10 shows all objects. 

 

 

Screen saver Back light saver 

If the screen is left untouched and reaches the time limit 

set here, the back light will be turned off. The unit is 

minute. Back light will be on again once the screen is 

touched. If [none] is set, the back light will always be on. 

Screen saver 

If the screen is left untouched and reaches the time limit 

set here. The current screen will automatically switch to a 

window assigned in [Saver window no.].The setting unit is 

minute. If [none] is set, this feature is disabled. 
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Saver window no. 

To assign a window for screen saver. 

Fast 

selection 

buttons 

This setting is applicable for eMT, iE, XE, mTV, and iP Series. 

Setting the attributes for fast selection button for Window 

No. 3. To use the fast selection button, create Window No. 

3 first. 

Attribute 

Enable or disable fast selection window. Select [Enable] and 

click [Settings] to set the attributes, including color and text 

of the button. 

Position 

Select the button position on the screen. If [Left] is chosen, 

the button will show at bottom left side of the screen; if 

[Right] is chosen, the button will show at the bottom right 

side of the screen. 

Settings 

Set the shape and label font of the Fast Selection Button. 

Hide button when HMI starts 

The Fast Selection Button will be hidden, calling it out 

requires system registers LB-9013~LB-9015. 

Monitor 

Mode 

This setting is applicable for cMT Series. 

Window no. 3 in the project is monitored in this mode in 

cMT Viewer. The user can select up to 50 cMT Series HMIs 

to monitor in cMT Viewer, and in 3x3 or 5x4 tile view. 

Event Use LW9450~9455 as time tags of event logs 

When this option is selected, Event Log will use the 

following time tags to show the time that the event is 

triggered. 

LW-9450: time tag of event log ς second (range: 0~59) 

LW-9451: time tag of event log ς minute (range: 0~59) 

LW-9452: time tag of event log ς hour (range: 0~23) 

LW-9453: time tag of event log ς day (range: 1~31) 

LW-9454: time tag of event log ς month (range: 1~12) 

LW-9455: time tag of event log ς year (range: 1970~2037) 

Please note that the system will not be able to use these 

time tags when one of them exceeds acceptable range. 

 Click the icon to download the demo project. Please 

confirm your internet connection before downloading the 

demo project. 

Keyboard The window number in which the keyboard is placed. 

When using Numeric Input or ASCII Input objects, the type 

of keyboards can be selected. Up to 32 keyboards can be 

https://dl.weintek.com/public/MT8000/Project/System_Sample/Demo_Time_tags_of_eventlog.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Demo_Time_tags_of_eventlog.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Demo_Time_tags_of_eventlog.zip
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added. To design a keyboard, a window should be 

designated for creating it. Press [add] after creating, and 

add the window to the list. 

See ά12 Keyboard Design and Usageέ. 

External keyboard layout 

The available USB keyboard layouts are QWERTY and 

AZERTY. System register LW-9199 allows switching keyboard 

layouts on HMI.  

Caret color / Select color 

This setting is applicable for eMT, iE, XE, mTV, and iP Series. 

Set the color of caret that appears when entering data in 

Numeric Input and ASCII Input objects, or change the 

selection color. 

Project 

protection 

Projects can be restricted to be executed by a specific HMI. 

 See ά30 Project Protectionέ. 

5.5. System Setting 

[System Setting] is used to configure different features of EasyBuilder Pro. 
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Some features are duplicated from system registers, such as, [Hide system setting bar 

(LB-9020)], [Hide mouse cursor (LB-9018)], [Disable buzzer (LB-9019)], and [Disable upload 

function (LB-9033)]. Users can also set these features via system tag.  

To select a system tag, select [Address] » [System tag] check box when adding a new object and 

then select the [Address Type].  

To browse all the system tags, Select [Project] » [Tag] » [System] from the main menu of 

EasyBuilder Pro. 

 

Setting Description 

Startup language after 

redownloading the 

project 

Set the language to use when HMI starts after 

the project is re-downloaded. 

Delay time of device 

communication after 

HMI starts 

Certain PLC models need relatively longer 

startup time. In order to prevent 

communication error that occurs when HMI 

attempts to communicate with a PLC that has 

not yet started, a delay time can be set. 

Include delaying the execution of all init. 

Macros when HMI starts. 

With this option selected, the macros that 

have [Execute one time when HMI starts] 

enabled will also be delayed. 

Execute init. MACRO 

when power on 

Designate the macro to be executed when HMI 

power on. 

Auto logout If leaving HMI untouched for longer than the 

set time, the objects protected by security 

classes will not be able to operate. The user ID 

and password must be entered again to unlock 

it. 

Hide system setting bar Hide the system setting bar in the bottom right 

corner of the HMI screen. 

Hide mouse cursor Hide the mouse cursor in HMI screen. 

Mouse cursor size Set mouse cursor size. 

Sound control With each touch on a button, a sound is 

emitted: A sound is emitted when touching a 

button. 

With Each operation from a button, a sound is 

emitted: When the [Min. press time] is 

specified, there may be a time gap between 

touching the object and the action of the 
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object. With this option selected, the sound is 

emitted when the object actions. 

Disable sound output: Mute HMI. (Not 

including the sound played when tapping 

system setting button on HMI.) 

Disable upload function 

(effective after rebooting 

HMI) (or set LB9033 ON) 

Disable HMI to upload project. 

Use a disconnection icon 

or relative objects when 

device communication 

fails 

If selected, a disconnection icon is 

displayed on relevant objects 

when failing to communicate with 

the device. 

This icon will be shown in the 

lower right corner of the 

object. 

This icon will only show for 

disconnection after successful connection. 

Enable watch dog 

(LB-9049) 

Watchdog automatically reboots the system 

after the HMI stops functioning for a specified 

period of time. 

Enable font preloading 

(optimize performance 

but HMI may start 

slower) 

(cMT Series only) 

With this option selected, the speed of 

changing windows that contain more texts is 

optimized. Please note that using this feature 

may slow down HMI boot time. 

5.6. Remote 

Parameters in this tab configure remote connections. Certain functions can be carried out 

using system registers. 
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Setting Description 

Prohibit remote HMI 

connecting to this 

machine 

Prohibit the connection with a remote HMI. 

The remote HMI will not be able to control the 

local HMI. 

Prohibit password 

remote-read operation 

(or set LB9053 ON) 

Prohibit Remote HMI to read Local HMIΩs 

project password and user password. 

Prohibit password 

remote-write operation 

(or set LB9054 ON) 

Prohibit Remote HMI to write to Local HMIΩs 

project password and user password. 

VNC Server If [Password free] check box is selected, the 

client can connect with HMI via VNC without 

entering the password. 

If [Monitor mode] check box is selected, the 

HMI connected via VNC can only be monitored 

but not controlled. 
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If [Password from project] check box is 

selected, set the password for VNC login. 

Easy Access server Login EasyAccess 1.0 server: 

Through this technology, users can easily 

access to any HMI connected to the internet 

and operate them on PC just like holding touch 

screen in hand.  

Easy Access does not transmit updated graphic 

images directly but only the real time data. 

This makes transmission really quick and 

efficient. PƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ά9ŀǎȅ!ŎŎŜǎǎ Manualέ 

for more information. 

Location of EasyAccess 2.0 server: 

Current location includes Global and China. 

 Click the icon to watch the demonstration 

film. Please confirm your internet connection 

before playing the film. 

Diagnoser Enable 

When selected, cMT Viewer will allow 

diagnostic operations when connecting to a 

cMT model. System register LB-12656 can also 

be used to control Diagnoser. 

Password free 

Enabling Disgnoser will not require password 

login. System Register LB-12657 can also be 

used to set whether a password is required. 

Password 

Enter the password for logging in Diagnoser. 

System register LW-11756 (4 words) can also 

be used to set this password. 

cMT Viewer Max connect count 

Allows specifying the allowable number of cMT 

Viewer connections for a local cMT HMI. 

5.7. Security 

Parameters in this tab configure the user passwords and security classes. There are two 

authentication modes: General Mode and Enhanced Security Mode. 

 For more information, see ά10 Securityέ. 

https://www.youtube.com/watch?v=R3gkBhQFlJ4
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 General Mode 5.7.1.

 

Up to 12 sets of user and password are available. Password should be one non-negative integer. 

Once the password is entered, the objects that the user can operate are classified. 

There are six security classes available: A to F. 

If [None] is selected for an object, every user can access this object. 

For example, when the security class of User No. 3 is set as the preceding figure, User No. 3 

could only access objects of classes A, B, C ŀƴŘ άƴƻƴŜέΦ 

 

 Enhanced Security Mode 5.7.2.

At most 11 users can be set here. An [Administrator] user is provided in this mode. An 

[Administrator] has all privileges and can operate all object classes. User passwords must be 

alphanumeric and each user can have up to 12 classes: A to L. 
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Setting Description 

Editable Determines whether other users can change the 

password settings or see passwords. 

 

Enable read-only 

Under this mode, the settings can be viewed but not 

changed. 

Mask password 

Passwords are masked by asterisks (*). 

Select operable 

classes for each 

user 

When [Use existing user accounts on HMI] check box 

is selected, the user accounts existing on HMI will not 

be erased after downloading the project file to HMI. 

Administrator Default administrator account, cannot be deleted, has 

all privileges, and cannot be changed. Enhanced 

Security Mode can be used with Option List object. It 

displays the account names and privileges. If [Secret 
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user] is checked, the account names and privileges 

will be hidden in Option List. 

Control address An address for users to manage the accounts directly 

on HMI. 

Project password When this password is enabled, it has to be entered 

before editing the project file. 

Select [Enable] and then click [Settings] to set the 

password.  

Execute auto. 

Login/logout 

when insert an 

USB key into HMI 

This feature allows automatic login / logout using an 

USB security key. The login / logout status will be 

written into a designated address. Insert the USB disk 

to HMI to log in, and remove the USB disk to log out. 

The result codes of login / logout: 0x00: No action, 

0x01: Login succeeds, 0x04: Login fails, 0x08: Logout 

succeeds, 0x10: Logout fails. 

5.8. Extended Memory 

Parameters in this tab determine the location of the extended memory. 

 

Extended Memory is numbered from EM0 to EM9. It works in a way similar to other device 

types (i.e. LW or RW address). Users can simply select from [Device type] list while adding a 

new object. Size of each extended memory is up to 2G word. 
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Extended memories are saved as files in [SD card] or [USB disk]. [EM0] to [EM9] are saved as 

άŜƳлΦŜƳƛέ to άŜƳфΦŜƳƛέ respectively. Users can use RecipeEditor.exe to open these files and 

edit the data in the extended memory. 

Data in extended memory will not be erased when power is cut, which means next time when 

start up HMI again, data in the extended memory remains the same as before power off. This is 

similar to recipe data (RW, RW_A). 

When the device of extended memory does not exist and to read data in it, the data content 

ǿƛƭƭ ōŜ άлέΤ to write data to a device that does not exist, the "PLC no response" message will be 

shown in HMI. 

Users can insert or remove the external device to or from HMI without cutting the HMI power 

to update or take data in extended memory. 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

  

https://www.youtube.com/watch?v=WiGWyXpZrv0
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5.9. Printer / Backup Server 

Configure remote printer / backup server. 

 

Setting Description 

Output  

settings 

Orientation 

Set how will words or pictures be printed out, [horizontal] 

or [vertical]. 

Printer size 

Set to print out in [Original size] or to [Fit to printer 

margins]. 

Margin 

Set the top, bottom, right and left margin width. 

Communication 

settings 

 

IP address 

Assign the IP address of the printer via network. 

 

[Port], [User name], [Password] 

Specify the data to log in server.  

Port can be set from 1 to 65535. 

Maximum length of user name or password is 12 

characters. 

 For more information, see ά26 EasyPrinterέ. 

 Click the icon to download the demo project. Please confirm your internet connection 

before downloading the demo project. 

https://dl.weintek.com/public/MT8000/Project/System_Sample/Printer_Backup_Server.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Printer_Backup_Server.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Printer_Backup_Server.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Printer_Backup_Server.zip
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5.10. Time Sync./DST 

Synchronize HMI time with NTP server. 

  

Setting Description 

HMI time zone Select HMI time zone. 

Enable time 

synchronization 

via NTP (Network 

Time Protocol) 

server 

Execute time synchronization when HMI starts 

Automatically synchronizes HMI time with the 

designated NTP server when HMI starts. 

Server response time 

Select NTP server time zone. 

Network time server 

Provides four fields to fill in Network Time Servers for 

userΩs device. If the synchronization with server 1 fails, 

the system will try to synchronize with server 2, and so 

on. If HMI time cannot synchronize with any of the 

Network Time Servers, the system register LB-12055 will 

change to ON status. 

Update interval 

The frequency of synchronization, the range is from 10 to 
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86400 seconds. 

Automatically set 

daylight saving 

time (DST) 

Start / End 

Set the start/end of Daylight Saving Time.  

The option [Last] may refer to the 5th or 6th week 

depending on the selected month. 

Daylight bias 

Set the time zone's offset during DST. 

Note 

Â When DST ends, and the time falls back, the Trend Display object in Real-time mode will 

stop refreshing for the overlapping hour(s) when it just going back to standard time. 

However, historical data will not be affected. 

Â When DST ends, adjusting HMI time (manually or by network) back to the DST period will 

not be effective to the system. The system register LB-12355 stays OFF. 

Â When DST ends, and the time falls back, the system will not start DST for the overlapping 

hour(s). The system register LB-12355 stays OFF. 

Â Before DST starts, adjusting HMI time (manually or by network) into the DST period will 

start DST. The system register LB-12355 will be set ON. The HMI time will be the specified 

time without adding the offset. 

Â During DST, adjusting HMI time (manually or by network) to a time that is not within DST 

period will end DST. The system Register LB-12355 will be set OFF. The HMI time will be 

the specified time without subtracting the offset. 

Â This feature does not yet support the DST in Southern Hemisphere. 

For more information on system registers relevant to DST, see ά22 System Registersέ. 

5.11. e-Mail 

Select [Enable e-Mail function] check box to configure the parameters. 

When [Use existing contact settings on HMI] check box is selected, the system will use the 

contact settings in HMI after downloading the project to HMI, or use the following settings 

when no contact is found in HMI. 
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Setting Description 

SMTP Settings Server: Set SMTP Server. 

Port: Set communication port. 

User name: Set e-mail address. 

Password: Set e-mail password. 

Confirm Password: Confirm e-mail password. 

SMTP server requires authentication: 

Decide whether Secure Password Authentication is needed 

when log in e-mail. 

Use the following type of encrypted connection: 

Decide whether the encrypted connection (TLS, SSL) is 

needed when sending e-mail. 

Sender 

Information 

 

Name: 

Enter the sender name or use the local HMI name in the 

device list, or the name specified using system register 

LW-10884 (HMI name). 
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Mail Address: 

Setting e-mail address. 

Error message When an error occurs in email delivery, the error message 

sent from SMTP server can be shown in the designated 

address. 

For more information on system registers relevant to 

mail delivery, see ά22 System Registersέ. 

Error 

notification 

Turn OFF LB-12053 or LB-12054 before send an e-Mail 

When enabled, system registers LB-12053 or LB-12054 will 

be turned off before sending e-mail, otherwise, when an 

error occurs in email delivery, the register remains ON. 

Test SMTP 

Settings 

Verify SMTP settings in advance by sending a test email to 

the specified e-mail address. 

 

Click [Recipients] to open the following dialog to edit contacts: 

  

Setting Description 

Contact list Add or remove contacts from the list. 

Group 

Information 

 

Group up contacts. 

No. of groups: 

Set no. of contact groups, according to the number, the 

groups are named from A to P and up to 16 groups can be 

set. 

Current group: 

Displays the group that includes the contacts above. 

Comment: 

Enter a description for the current group. 
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 For more information on sending Event Log, see ά7 Event Logέ. 

 For more information on e-mail related system registers, see ά22.3.40 e-Mailέ. 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

 Click the icon to download the demo project. Please confirm your internet connection 

before downloading the demo project. 

5.12. Cellular Data Network 

This tab is for setting cellular data. Cellular data network settings may differ from one model to 

another. 

Applicable models: 

cMT-SVR (OS ver. 20151127 or later) 

cMT3072/cMT3090/cMT3103/cMT3151 (OS ver. 20180723 or later) 

cMT-HDM/cMT-FHD (OS ver. 20190130 or later) 

Attaching a 3G/4G USB dongle to the USB port enables the cMT-SVR to connect to 3G/4G 

networks. 

 

Setting Description 

Use existing contact 

settings on HMI 

If this check box is selected, the cellular data currently 

in HMI will be used. When no specific settings are 

required, generally, [PIN code] is ά0000έ, [APN] is 

άinternetέ, and [Username], [Password], [Dial number] 

are optional. 

 

The relevant registers: 

LW-11297: (16 words) : PIN code of SIM card (cellular network) 

LW-11313: (16 words) : Access Point Name (cellular network) 

LW-11329: (16 words) : username (cellular network) 

https://dl.weintek.com/public/eMT3000/Project/System_Sample/e_Mail.zip
https://dl.weintek.com/public/eMT3000/Project/System_Sample/e_Mail.zip
https://www.youtube.com/watch?v=hr9mxc9ieoM
https://dl.weintek.com/public/eMT3000/Project/System_Sample/e_Mail.zip
https://dl.weintek.com/public/eMT3000/Project/System_Sample/e_Mail.zip
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LW-11345: (16 words) : password (cellular network) 

LW-11361: (16 words) : dial number (cellular network) 

LW-11377: (16bit) : stop (set 0)/start (set 1) connection (cellular 

network) 

LW-11378: (16bit) : last error code (0:success, 1:incorrect PIN code, 

2:no SIM, 3:no device, 4:puk locked, 5:other) (cellular 

network) 

LW-11379: (16bit) : connection status (0:no device, 1:disconnect, 

2:connecting, 3:connected) (cellular network) 

USB Tethering 

By connecting an Android® mobile phone with HMI using a micro USB cable, or any USB data 

cable that is compatible with the phone, the internet connection of the phone can be shared 

with HMI. On the Android mobile phone please enable USB Tethering. 

 
When successfully connected, the following registers can be used to monitor and control the 

connection status. 

LW-11380:  (16bit) : stop (set 0)/start (set 1) connection (USB 

tethering) 

LW-11381:  (16bit) : connection status (0:no device, 1:disconnect, 

2:connected, 3:fail, 4:OS not support, 5:HMI not 

support) (USB tethering) 

 Click the icon to download the demo project. Please confirm your internet connection 

before downloading the demo project. 

 

https://dl.weintek.com/public/eMT3000/Project/Part_Sample/USB_Tethering_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/USB_Tethering_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/USB_Tethering_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/USB_Tethering_Demo.zip
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 Window Operations 6.
This chapter describes different types of windows and how to create, set and delete a window. 

 

6.1. Overview ....................................................................................................................... 6-2 

6.2. Window Types .............................................................................................................. 6-2 

6.3. Create, Set, and Delete a Window ................................................................................ 6-4 

6.4. Window Transparency .................................................................................................. 6-7 

6.5. Editing Tips .................................................................................................................. 6-10 
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6.1. Overview 

A window is a basic element in a project. With a window, all kinds of information like objects, 

pictures, and texts can be displayed on HMI screen. In total, 1997 windows numbered from 3 ~ 

1999 in EasyBuilder Pro can be built and edited. 

6.2. Window Types 

There are 4 types of windows, each with different functions and usages: 

 ̧ Base Window 

 ̧ Fast Selection Window 

 ̧ Common Window 

 ̧ System Message Window 

 Base Window 6.2.1.

The most frequently used window, except for main screen, it can also be: 

 ̧ A background of other windows. 

 ̧ A keyboard window. 

 ̧ A pop-up window of Function Key object. 

 ̧ A pop-up window of Direct Window and Indirect Window objects. 

 ̧ A screen saver. 

Note 

Â Base Window should be in same size as the HMI screen. Therefore, the resolution of the 

base window should be set to the resolution of HMI. 

 Fast Selection Window 6.2.2.

Window no. 3 is the default Fast Selection Window. This window can co-exist with base 

window. Generally, it is used to place the frequently-used buttons on the lower-left side or the 

lower-right side on the screen. Please create window no. 3 first, and set the relevant properties 

in [System Parameter Settings] » [General] tab. Apart from showing or hiding fast selection 

window with the button on the screen, there are system registers to do so: 

[LB-9013] Fast Selection window control [hide(ON)/show(OFF)] 

[LB-9014] Fast Selection button control [hide(ON)/show(OFF)] 

[LB-9015] Fast Selection window/button control [hide(ON)/show(OFF)] 

Note 

Â cMT Series does not support Fast Selection Window. 
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 Common Window 6.2.3.

Window no. 4 is the default Common Window. Objects in this window will be displayed in 

other base windows, not including pop-up windows. Therefore, the common objects in 

different windows are often placed in common window.  

When operating HMI, select [Function Key] » [Change common window] to change the source 

of common window. 

In menu[File] » [Preferences] » [Display] select whether or not to [Display Common Window 

objects on Base Windows] when editing a project. This can avoid overlapping objects in base 

window with objects in common window. 

 

 System Message Window 6.2.4.

Windows No. 5, 6, 7, 8 are the default System Message Windows: 

 

Window No. 5: PLC Response 

When the communication between PLC and HMI is 

disconnected, this message window will pop up 

automatically right on the base window currently opened. 

This window can be disabled by system registers. 

 

Window No. 6: HMI Connection 

When failing to connect HMI with a remote HMI, this 

message window will pop up automatically. 

 

 

Window No. 7: Password Restriction 

When attempting to control an object without 

authorization, this window may pop up as a warning 

depending on the settings of the object. 
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Window No.8: Storage Space Insufficient 

When HMI flash memory, USB disk or SD card run out of 
storage space, this message window will pop up 
automatically. (When the memory space is under 4 MB) 

The following system registers can be used to check the free memory space in HMI, USB disk, 

or SD card: 

[LW-9072] HMI current free space (K bytes) 

[LW-9074] SD current free space (K bytes) 

[LW-9076] USB disk current free space (K bytes) 

To check if there is sufficient storage in the devices, the following system registers can be used. 

These addresses will set ON when the space is under 4 MB. 

[LB-9035] HMI free space insufficiency alarm (when ON) 

[LB-9036] SD card free space insufficiency alarm (when ON) 

[LB-9037] USB disk free space insufficiency alarm (when ON) 

For more information, see ά22 System Registersέ. 

The text shown in windows no. 5 ~ 8 can be edited for easier reference. 

Note 

Â A screen can display up to 16 pop-up windows simultaneous including System Message 

Window, Direct Window and Indirect Window. 

Â The system does not allow opening the same window with two Direct (or Indirect) 

Windows in one base window. 

Â Windows no. 3 to 9 are used by the system only, and windows no. 10 to 1999 can be 

edited based on actual usage. 

Â For cMT Series, only 1 pop-up window can be displayed at a time. 

6.3. Create, Set, and Delete a Window 

Check the existing windows in [Window Tree]. 

[Object list] displays window numbers and window names. Opened windows are marked with 

(*) sign. Press the (+) sign to see the object ID, address and description in this window. 

[Window preview] displays the thumbnails of windows. 
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 Creating and Setting a Window 6.3.1.

In window tree right click on a window number then select [New]. 
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Setting Description 

Name The name appears on the title bar and also in window tree. 

Window no. Can be 3 to 1999. 

Size Set the window size in accordance with the HMI resolution. 

Underlay 

window 

Underlay Window can be seen as an extra Common 

Window. When designing the project, some commonly 

used objects are used in some windows but not all. These 

objects can be placed in underlay window. 

Each base window can set three underlay windows as 

background, from [Bottom] to [Top]. The objects in underlay 

windows are displayed in this order in base window. 

Pop-up 

window 

Base window can also be used as a pop-up window. Use [X] 

and [Y] to set the coordinates indicating where in the screen 

will this base window pop up. The origin of the coordinates 

is the upper-left corner of the window. 

Monopoly If the option is selected, when the base window pops up, no 

operations of other pop-up windows and background 

windows are allowed until the monopoly window is closed. 

LŦ ŀ ōŀǎŜ ǿƛƴŘƻǿ ƛǎ ǳǎŜŘ ŀǎ ŀ ƪŜȅōƻŀǊŘ ǿƛƴŘƻǿΣ άMonopoly" 

is automatically enabled. 

Title bar If the option is selected, a title bar appears on a system 

message window. This feature is only available for system 

message windows no. 5 to no. 8. 

Macro Select the macro to be executed when the window opens or 

closes, or the macro to be executed periodically (each 500 

ms). 

Please build the macro in advance. 

Note 

Â The objects in underlay window cannot be edited from the base window that displays 

them. To edit those objects, please open the underlay window where they are located. 

Â When the window number of the underlay window used by the base window is identical 

to the pop-up window, the pop-up window is disabled. 

Â When base window and pop-up window use the same underlay window, the objects in 

the underlay window cannot be displayed in pop-up window. 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

Or, from the main menu click [View] » [Open Window] and then click [New] and select the type 

of the window and click [OK]. 

https://www.youtube.com/watch?v=VWKM3gQrm54
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Ways to call up [Window Settings] dialog: 

 ̧ Right click on the window number in the window tree and select [Settings]. 

 ̧ In [View] » [Open Window] select the window then click [Settings]. 

 ̧ In the window, right click when no object is selected, and select [Attribute]. 

 Open, Close, and Delete a Window 6.3.2.

The ways to open an existing window: 

 ̧ Double click on the window number in the window tree. 

 ̧ In the window tree, select the window, right click, and then select [Open]. 

 ̧ In [View] » [Open Window] select the window then click [Open]. 

 

The ways to close or delete an existing window: 

 ̧ In the window tree, select the window; right click, then select [Close] or [Delete]. 

 ̧ In [View] » [Open Window] select the window then click [Delete]. 

 ̧ To delete a window, please close it first. 

6.4. Window Transparency 

The Opacity setting in the View tab is used to adjust transparency effect of the common 

window, overlay windows, and window layers.  
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As shown in the following screenshots, greater Opacity makes the object in the relevant 

window more visible. 

 

Additionally, the cMT Series models support setting window transparency. This setting is 

applicable for popup windows, Direct / Indirect Windows, and keyboard windows. The settings 

dialog box and the effect are shown in the following screenshots. Greater transparency can 

make the object on the base window more visible when it is covered by the popup window. 
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Example 
Setting transparency to 40%: 

 

Setting transparency to 90%: 
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6.5. Editing Tips 

EasyBuilder Pro provides a user-friendly interface with which users can easily edit projects. The 

following are some editing tips. 

 Non-display Area, Select Tool, and Hand Tool 6.5.1.

As shown in the following screenshot, two areas can be found in the editing window: editing 

area and non-display area. The non-display area refers to the area outside the editing area (the 

one in the middle). Objects placed in the non-display area will not be visible on HMI, and 

communication with devices continues. The invisible objects such as Meter, Time-based Data 

Transfer, or Text objects used for comments can be placed in this area to avoid overlapping 

with other objects in the editing area, which adds difficulty to project editing. The objects 

placed in the non-display area remain effective. 
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Select Tool 

Clicking this icon in the toolbar changes the cursor to the Select Tool. Select a 

single object by clicking it, or select multiple objects by clicking on an empty 

part of the editing screen and then drag a box around the objects. 

 

Hand Tool 

Clicking this icon in the toolbar changes the cursor to the Hand Tool. The Hand 

Tool allows moving through the project screen by simply left clicking the mouse 

and dragging anywhere. 

 Ruler 6.5.2.

 

 

Selecting [View] » [Ruler] adds rulers to the top and left of the editing screen. Guides can be 

added from the ruler by right click on the ruler. Objects will automatically snap to the guides 

when moved or resized. 
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Setting Description 

Delete Delete the guide. 

Edit 

 

Adjust the position of the guide. 

Settings 

 

Add or delete multiple guides. 

Selecting [File] » [Preferences] » [Grid] opens the following window for setting the color or style 

of the Guides. 
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 Quick Copy 6.5.3.

Quick copy can be carried out by pressing and holding Ctrl key on the keyboard while an object 

is selected, and then drag the cursor to a new location where the object will be created. 
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 Event Log 7.
This chapter explains how to set and use Event Log. 

 

7.1. Overview ....................................................................................................................... 7-2 

7.2. Event Log Management ................................................................................................ 7-2 

7.3. Creating a New Event Log ............................................................................................. 7-8 
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7.1. Overview 

The following are the basic steps to use Event Log: 

1. Define event content and trigger condition. 

2. Trigger event according to the condition. 

3. Save the event log to the specified device. 

4. View the process of event by using the relevant objects. 

This chapter will explain how to set and use Event Log. 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

7.2. Event Log Management 

Firstly, define the event content then use Alarm Bar , Alarm Display , Event Display  

objects to view the process of the whole event from triggeringʤwaiting to be processedʤ

return to normal. The upper limit for the number of event logs is 10000. 

https://www.youtube.com/watch?v=pW4otKI1I6E
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 eMT, iE, XE, mTV, iP Series 7.2.1.

 

 

Setting Description 

Category Classifies events by dividing them into 0 ~ 255 categories. 

Select one category to add or view event log. In the bracket 

άώ ϐέΣ ƛǘ ǎƘƻǿǎ ǘƘŜ number of events are in this category. 

History 

files 

Saves event log files to the specified location. Once an event 

occurs, the HMI immediately saves the history file. When 

executing On-line or Off-line Simulation on PC, the files will 

be saved in the HMI_memory / SD_card / USB folder under 

the installation directory. 

Preservation limit 

This setting determines the maximum number of Event Log 

files to be preserved in HMI memory. This does not include 

the file generated today. That is, if [Days of preservation] is 

set to 2; the two latest files excluding the file generated today 

will be kept. The files that are not within the range will be 

deleted automatically for saving the storage space. 
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Print In [System Parameter Settings] » [Model], select a printer and 

set the printing format. 

Copy Copy the selected item. 

Paste Overwrites the selected item with the new items. A message 

window will pop up to confirm this operation. 

Paste  

(Add Mode) 
Appends as a new entry. 

 cMT Series 7.2.2.

 

Setting Description 

Category Classifies events by dividing them into 0 ~ 255 categories. 

Select one category to add or view event log. In the bracket 

άώ ϐέ, it shows the number of events are in this category. 

Edit category name mappingΧ Opens a category name table 

which allows editing corresponding category names. 

Control 

address 

If select [Enable] check boxes under both [Control address] 

and [History files], entering a specific value in the control 

address sends the corresponding command. 
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Value Command 
1 Clear the event log on cMT HMI 
2 Synchronize event log to the external device 
3 Synchronize event log to the external device and then 

clear the event log on cMT HMI 
4 Use the history data stored in USB disk / SD card after 

changing HMI 
11 Update event log message contents by reading a new 

String Table 

If none of these values is entered, the system will synchronize 

data in the same rules as [History files] setting explained 

below. 

Status 

Error 

(cMT Series) 

When LW-n is used as the control address, the four 

consecutive addresses following LW-n (LW-n+1~LW-n+4) will 

show status and error, please see the prompt in the settings 

dialog box. 

 

Value Status address: LW-n+1 and LW-n+3 
0 Disconnected from external device or database 
1 Connecting with external device or database 
2 Connected with external device or database 
3 Storing records into the archive. When this is done, the 

value returns to 2. 
Value Error address: LW-n+2 and LW-n+4 
0 None 
1 Unknown error 
2 Failed to connect with external device or database 
3 Access denied 
4 Wrong database name 
5 Inconsistent data format 
6 Failed to open table 
7 Failed to create table 
8 Failed to write table 

 

History files Saves the synchronized data to SD, USB disk, or database. The 
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rules of synchronizing the data saved in the external device 

are: 

Â When the number of events is under 10000, the events 

will be temporarily saved in cMT HMI. 

Â When the number of events reaches 10000, and [HMI 

memory (10000 limited)] is selected, the system will 

automatically save the data to the external device and 

deletes the earliest 1000 events in cMT HMI. 

Â When the number of events reaches 10000, and [HMI 

memory (until space full)] is selected, the system will 

keep on saving the data to HMI memory without 

deleting the earlier events. In this case the data may not 

be synchronized to database. 

Â If the external device already contains some events, the 

new data is appended without overwriting the original 

data each time in synchronization. 

Â When the external device is removed from cMT HMI, or 

cMT HMI is disconnected from database server, if the 

connection is recovered before the number of events 

exceeds 9000, the events occur during disconnection will 

be saved to cMT HMI. If the number of events exceeds 

9000 during disconnection, the earlier data will be 

deleted, and cannot be synchronized by recovering 

connection. 

Auto sync. 

periodically 

Data will be automatically synchronized to the designated 

external device in the specified time interval, regardless of 

the rules explained above. 

Unit: Minute(s) 

Range: 1~1440 

Preservation 

limit  

This setting determines the maximum number of Event Log 

files to be preserved in HMI memory. This does not include 

the file generated today. That is, if [Days of preservation] is 

set to 2; the two latest files excluding the file generated today 

will be kept. The files that are not within the range will be 

deleted automatically. The system checks the time of the files 

and deletes earlier files only during synchronization. 

Display 

history from 

With this option selected, Event Log displays the history data 

read from database. 
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database 

Copy Copy the selected item. 

Paste Overwrite the selected items with the clipboard contents.  

A message window will pop up to confirm this operation. 

Paste  

(Add Mode) 
Append the clipboard contents to the end of the list. 

Note 

Â Before removing SD card /  USB disk, or disconnecting from database server, please 

synchronize event log data by using control address. 

 Excel Editing 7.2.3.

Click on the Excel icon in Event Log setting dialog box to open the Excel template for a 

reference of editing. This template is under the installation directory, the file name is 

EventLogExample.xls. This template includes the ready-made dropdown lists and validation 

mechanism. 

 

Note 

Â [System tag] and [User-defined tag] cannot be set to true simultaneously, otherwise, the 

system will view the User-defined tag to be a System tag, and [User-defined tag] to be 

false. If setting [Device type] to [User-defined tag], please set [System tag] to false. 

Â When setting [User-defined tag] to true, if the system compares the [Device type] with 

the user-defined tag in the system, and no suitable tag is found, the system will set the 

[User-defined tag] in event log to false 

Â [Color] format is R:G:B, each should be an integer form 0 to 255. 

Â Before importing Label Library / Sound Library, please make sure the library names exist in 

the system. 

 Quick View of Errors 7.2.4.

When compiling the project, the errors in Event Log will be displayed in the Compile window. 

To open Event Log and view the errors, double click on the item in the Compile window.  
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7.3. Creating a New Event Log 

General Tab 

Click [New] in the [Event (Alarm) Log] dialog box. 
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Setting Description 

Category Select event category, the range is from 0 to 255. 

Priority 

level 

When the number of events equals to the max number of the 

system (default 1000), the lower priority events will be 

deleted and new events will be added in. 

Save to 

history 

In Event Log main settings, if [Save to HMI memory] check 

box under [History files] group box is selected, selecting [Save 

to history] here determines whether each separate event 

should be saved as historical file. 

Push 

notification 
(EasyAccess 
2.0) 

With this check box selected, each time when an event 

occurs, userΩs iOS®/Android® device can run EasyAccess 2.0 

application to receive push notifications. 

Delay time 
for event 
monitoring 
when HMI 
resets 

This feature is used to set the delay time of Event Log after 
HMI reboot, in order to avoid false alarm that occurs upon 
HMI reboot due to uninitialized values. This feature is often 
used with [Dynamic condition value]. The delay time only 
occurs once upon HMI reboot.  

Read 

address 

The system reads data from this address to check if the event 

matches the trigger condition. 
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Notification When enabled, the system will set the specified address ON 

or OFF when the event is triggered. 

Follow 

The notification bit will reset to its original state once the 

alarm condition returns to normal. For example, when the 

alarm is triggered, the state of the notification bit turns ON. 

When the alarm condition returns to normal, and [Follow] 

check box is selected, the state of the notification bit turns 

OFF. 

Condition When [Bit] is selected, Event Log will detect the state of a Bit 

address. 

When [Word] is selected, Event Log will detect the value of a 

Word address to check if it is greater than, less than, or 

equals to a specified value. See Example 1 and Example 2. 

Dynamic condition value 

Allows online change of the comparison value for trigger 

condition when the condition is a Word address type. If 

[Read/Condition use different addresses] is not selected, the 

source of condition value will be the next consecutive address 

from [Read address]. 

Read/Condition use different addresses 

Allows selecting the Word address type to be the source of 

condition value. 

 

Example 1 

 

 

The setting above indicates: 

When [Read address] value is greater than or equals to 29 (= 30 - 1)  

Or less than or equals to 31 (= 30 + 1), the event will be triggered. The trigger condition: 

29  [Read address] value  31 

After the event is triggered, when [Read address] value is greater than 32 (= 30 + 2) or less than 

28 (= 30 - 2) the system will return to normal condition: 

[Read address] value < 28 or [Read address] value > 32 
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Example 2 

 

 

The setting above indicates: 

When [Read address] value is less than 29 (= 30 - 1) 

or greater than 31 (= 30 + 1), the event will be triggered. The trigger condition: 

[Read address] value < 29 or [Read address] value > 31 

After the event is triggered, when [Read address] value is greater than or equals to 28 (= 30 - 2) 

or less than or equals to 32 (= 30 + 2) the system will return to normal condition: 

28  [Read address] value  32 

Message Tab 
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Setting Description 

Content The text content displayed in [Alarm Bar], [Alarm Display], 

and [Event Display] objects. Use the formats in the 

following two examples of WATCH addresses to use 

register data in content. The content in Label Tag Library 

and String Table can be used in the Event Log message. 

Font / Color / 
Background 
color 

The font / color / background color can be set respectively 

for each event. The font and color settings determine how 

[Alarm Bar] shows the text, while The font, color, and 

background color settings determine how [Alarm Display] 

and [Event Display] show the text. These settings are not 

available in the [Event Display] under History mode. 

Write value for 
Event/Alarm 
Display object 

When an event in [Event Display] or [Alarm Display] is 

acknowledged, the value is written to the assigned [Write 

address]. 

 Click the icon to download the demo project. Please 

confirm your internet connection before downloading the 

demo project. 
Sound If enabled, the selected sound will be played when an 

event is triggered. Continuous beep can also be enabled, 

which only stops when the event is acknowledged or 

recovered. 

For continuous beep, a delay time can be set between 

triggering the alarm and the start of beeping. 

 
 Click the icon to download the demo project. Please 

confirm your internet connection before downloading the 

demo project. 
Address of 
WATCH 1 ~ 8 

Click [Syntax] to edit and display the value in watch 

address when the event is triggered. Up to 8 watch 

addresses can be set. 

 Click the icon to download the demo project. Please 

confirm your internet connection before downloading the 

demo project. 

https://dl.weintek.com/public/MT8000/Project/System_Sample/Demo_Event_Write_Address.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Continue_Beep.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Alarm_Event_Display_Watch.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Demo_Event_Write_Address.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Continue_Beep.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Alarm_Event_Display_Watch.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Demo_Event_Write_Address.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Continue_Beep.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Alarm_Event_Display_Watch.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Demo_Event_Write_Address.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Continue_Beep.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Alarm_Event_Display_Watch.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Demo_Event_Write_Address.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Continue_Beep.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Alarm_Event_Display_Watch.zip
https://dl.weintek.com/public/MT8000/Project/System_Sample/Demo_Event_Write_Address.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Continue_Beep.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Alarm_Event_Display_Watch.zip
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e-Mail Tab 

Please enable this function in [System Parameter Settings] » [e-Mail] first. 

 

Setting Description 

Recipients Select the [To], [Cc], and [Bcc] recipients. 

Subject Enter the subject of the e-mail. 

Message Enter the [Opening] and [Ending] content of an E-mail. 

Attach If the [Contains a screenshot of window] check box is 
selected, the screenshot of the selected window will be 
attached. 
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Statistics 

 

 

Setting Description 

Occurrence 

read and reset 

address 

If enabled, the number of occurrence of the event after 
HMI startup will be written to the designated word 
address. The word address can be read / written. 

Elapsed time 

read and reset 

address 

If enabled, from an event occurs to its recovery, the 
elapsed time (in seconds) will be written to the 
designated word address. The word address can be read / 
written. 

 Click the icon to download the demo project. Please confirm your internet 

connection before downloading the demo project. 

 

https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Event_Log_Statistics_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Event_Log_Statistics_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Event_Log_Statistics_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Event_Log_Statistics_Demo.zip
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 Data Sampling 8.
This chapter explains how to set and use Data Sampling. 

 

8.1. Overview ....................................................................................................................... 8-2 

8.2. Data Sampling Management ........................................................................................ 8-2 

8.3. Creating a New Data Sampling ..................................................................................... 8-2 

8.4. Synchronizing cMT Viewer data and Saving to External Device ................................. 8-11 

8.5. Checking History Data of a Specific Date on cMT Viewer. .......................................... 8-12 
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8.1. Overview 

After defining how the data is sampled, by sampling time, address, or data length, the sampled 

data can be saved to the designated location, such as HMI memory, SD card, or USB disk. Trend 

Display and History Data Display objects can be used to display sampling records. 

8.2. Data Sampling Management 

Create a new Data Sampling object first by the following steps: 

1. From the menu select [Data/History] and click [Data Sampling]. 

2. Click [New] to finish relevant settings. 

  

8.3. Creating a New Data Sampling 

The following introduces how to set a new Data Sampling. 

eMT, iE, XE, mTV, iP Series 
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Setting Description 

Sampling mode High priority 

Data sampling processes with this feature enabled will be 

prioritized. Please note that too many priorities can slow 

down update rate of other objects. 

Time-based 

Samples data in a fixed frequency. The [Sampling time 

interval] can be set from ά0.1 second(s) to 120 minsέ. 

Trigger-based 

Triggers data sampling by the status of a designated bit 

address. 

Mode Conditions to trigger Data Sampling: 

[OFF -> ON] Triggers sampling when the status of the 

address changes from OFF to ON. 

[ON -> OFF] Triggers sampling when the status of the 

address changes from ON to OFF. 

[OFF <-> ON] Triggers sampling when the status of the 

address changes. 

Set ON/OFF after triggered 

If selected, after triggering Data Sampling, the system will 

set the designated bit address back to ON/OFF state. 

Read address Specify an address to be the source of Data Sampling. To 

convert a data record, please use a user-defined 

conversion tag that allows [Read conversion]. For array 

addresses, the GetCnvTagArrayIndex function can get the 

relative array index and then calculate. 
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Data Record 

(Real-time) 

In Real-time Mode, when [Auto. stop] is not selected, the 

max. number of data records can be saved on HMI is 

86400. When the number of records exceeds 86400, the 

earliest data will be deleted. 

Data Format 

Data of different formats in consecutive registers can be 

sampled. For example, setting: LW-0 (16-bit Unsigned), 

LW-1 (32-bit Float), and LW-3 (16-bit Unsigned). The 

upper limit for the number of records is 1000. 

  

Auto. stop 

Data sampling will automatically stop when the number 

of records reaches [Max. data records]. 

See ά8.3.1 Demonstration of Auto. stopέ. 

Clear real-time 

data address 

Set when the bit address status changes from [OFF -> ON] 

or [ON -> OFF], clear the sampled data in Trend Display 

Real-time Mode. The number of data records returns zero 

but the data records that are already saved as history files 

will not be cleared. 

Hold address If the status of the designated address is set ON or OFF, 

sampling will be paused until the status of the designated 

address returns. 

History files Save to HMI momery 

Saves Data Sampling to HMI every 10 seconds. Or, use 

system register [LB-9034] to force storing data. See 

details on the restrictions of using LB-9034 in the Note 

below. 

Save to SD card / USB disk 

Saves Data Sampling to the specified external device. 

Each file consists of all records of a day 



Data Sampling 

 

EasyBuilder Pro V6.04.01 

8-5 

The data sampling file will be saved on a daily basis into 

the specified folder, and the file name will be 

yyyymmdd.dtl, indicating the date of the file. 

Folder name 

Specify Data Sampling file name which must be all in 

ASCII characters. The folder name will be written as: 

[Storage Location] \  [Folder Name] \  [File Name] 

Preservation limit 

Determines the number of data sampling files to be 

preserved. Please note that the current .dtl file is not 

included in this limit. That is, if this limit is set to 2, apart 

from the current file, two latest files will be preserved. 

Cutomized file 

handling 

This feature can be used to customize naming and 

management of data sampling files (*dtl). 

See ά8.3.2 Customized File Handlingέ. 

Note 

Â A Data Sampling may include more than one type of records. Data Sampling can retrieve 
different types of records at the same time. For example, if define three types of data, 4 
words in total, the system retrieves a 4-word data each time from the designated address to 
be the content in one Data Sampling. 

Â When using [Each file consists of all records of a day] and set [Preservation limit] to 2 files, 

the data of yesterday and the day before yesterday will be kept. Data that is not built in this 
period will be deleted to prevent the storage space from running out. 

Â When using [Customized file handling] and set [Preservation limit] to 2 files, not only the 
currently sampled file, another 2 newest files (3 files in total) will be kept. The rest of the 
data will be deleted to prevent the storage space from running out. 

Â When running simulation on PC, all data sampling will be saved to the datalog folder in 
C:\EBPro\ [Storage Location]\datalog. If you change the data format of data sampling, delete 
the previous data records in the installation directory to prevent the system from reading 
the old records. 

Â When saving files to USB disk or SD card, the capacity of a FAT32 folder depends on the 
length of the file names. Fewer files can be saved when the file names are longer. 

Â When using LB-9034, the shortest interval between two successful executions is 2 seconds. 
That is, after LB-9034 is triggered, it can be effective again 2 seconds later. 

 Click the icon to watch the demonstration film. Please confirm your internet connection 

before playing the film. 

cMT Series 

The settings are almost similar to eMT, iE, XE, mTV, iP Series. The following highlights the 

settings that are different. 

https://www.youtube.com/watch?v=8gBxEqiomm4
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Setting Description 

Data Record Data of different formats in consecutive registers can be 

sampled. The upper limit for the number of records is 

1000. 

Control 

address 

Entering a value in the control address sends the 

corresponding command. 

Value Command 

1 Clear the sampled data in HMI 

2 Synchronize data to the external device / database 

3 Synchronize data to the external device / database 

and then clear the sampled data in HMI 

4 Use the history data stored in USB disk / SD card 

after changing HMI 

5 As data sampling stops when HMI storage is full, this 

command allows restarting of data sampling when 

thereΩs free space 
 

Status & Error 

address 

When LW-n is used as the control address, the four 

consecutive addresses following LW-n (LW-n+1~LW-n+4) 

will show status and error, please see the prompt in the 

settings dialog box.  
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Value Status address: LW-n+1 and LW-n+3 

0 Disconnected from external device or database 

1 Connecting with external device or database 

2 Connected with external device or database 

3 Storing records into the archive. When this is done, 

the value returns to 2. 

Value Error address: LW-n+2 and LW-n+4 

0 None 

1 Unknown error 

2 Failed to connect with external device or database 

3 Access denied 

4 Wrong database name 

5 Inconsistent data format 

6 Failed to open table 

7 Failed to create table 

8 Failed to write table 
 

History files History data can be saved to USB disk, SD card, and 

Database Server. When the sampled data reaches 10000 

records, and [Save to HMI memory (10000 limited)] is 

selected, the sampled data is automatically saved to the 

selected external device, and the earliest 1000 records 

are deleted. When [Save to HMI memory (until space 

full)] is selected, the system will keep on saving data to 

HMI memory without clearing the earlier racords. In this 

case, the data will not be synchronized to Database. To 

save data in Database Server, please set the computerΩs IP 

address. 

See synchronization rules in ά8.4 Synchronizing cMT 
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Viewer data and Saving to External Deviceέ. 

See Database Server usage in ά13.44 Database 

Serverέ. 

Cutomized file 

handling 

This feature can be used to customize naming and 

management of data sampling files (*db). The current 

*db file is saved in HMI memory. Please note the 

following two points when Sync. Destination is USB disk / 

SD card: 

1. When *db file name changes, the *.db file with the 

former name will be synchronized to USB disk / SD 

card. 

2. If a new *db file is generated when thereΩs no existing 

USB disk / SD card on HMI, the earlier *db file will be 

deleted. For example, if 20161218.db is the current 

file, when 20161219.db is generated and no external 

device is inserted to HMI, and then 20161218.db will 

be deleted. 

Find Customized File Handling settings dialog box in 

ά8.3.2 Customized File Handlingέ. 

Auto sync. 

periodically 

Data will be automatically synchronized to the designated 

external device in the specified time interval, regardless 

of the rules explained above. Please note that the timer 

will reset when a control address is used. 

See ά8.4 Synchronizing cMT Viewer data and Saving to 

External Device or Database Serverέ. 

All record in 

one file 

When Sync. Destination is USB disk / SD card, the 

preservation limit is 1 to 65535 days. 

Customized file 

handling 

When Sync. Destination is USB disk / SD card, the 

preservation limit is 1 to 65535 files. 

When Sync. Destination is HMI memory, the preservation 

limit is 1 to 1000 files. 

History source Data can be read from USB disk, SD card, or Database. 
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 Demonstration of Auto. stop  8.3.1.

This feature depends on the arrangement of different objects and modes. (Set [Max. data 
records] to n.) 

Object [Auto. stop] not selected [Auto. stop] selected 

Trend Display- 

Real time 

Deletes the earlier 
records and displays the 
latest number of records 
(n) in Trend Display. See 
the following figure. 

Stops after reaching the 
specified number of 
data records (n). 

Trend Display- 

Historical 

Keeps on sampling data 
and displays all history 
data in Trend Display. 

Stops after reaching the 
specified number of 
data records (n). 

History Data 

Display 

Keeps on sampling data 
and displays all history 
data in History Data 
Display. 

Stops after reaching the 
specified number of 
data records (n). 

Data Sampling Keeps on sampling new 
data. 

Stops after reaching the 
specified number of 
data records (n). 

 

The figure illustrates how the data is sampled in Trend Display ς Real Time mode when [Auto. 

stop check] box is not selected. Set the number of data records to 10, when the 11th data is 

generated, the earliest record is deleted and the newest record is added. 

 

 Customized File Handling 8.3.2.

This feature can be used to customize naming and management of data sampling files (*.dtl , 

*db). 
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Setting Description 

File creation Automatic mode 

A new file will be created when the name of an existing 

file is changed. 

Trigger mode 

A new file will be created according to the [Trigger 

method] settings. 

Trigger method Limit by number of data records 

A new file will be created when the number of data 

sampling records reaches the specified "Max. data 

records in a file" 

Register status 

A new file will be created when the status of a designated 

bit address meets the specified condition. The condition 

is specified in Mode field. 

Set ON/OFF after triggered 

If selected, after the new file is created, the system will 

set the designated bit address back to ON/OFF state. 
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File name The file name can be an alphanumeric name, and certain 

half-width symbols are allowed. The file name can also be 

specified by a file name syntax.  

Dynamic format 

The file names can be set by a designated word address, 

or by a file name syntax indicating the current system 

time. The file name syntax can be specified by selecting 

time buttons or entering the syntax in Format field. The 

length limit is from 1 to 25. 

The following half-width characters are not allowed: 

\  κ Υ ϝ Κ ά ғ Ҕ μ 

Note 

Â If both [Limit by number of data records] and [Dynamic format] check boxes are selected, 

before startup HMI, please enter the name in the designated register for Dynamic Format, 
otherwise, it is impossible the reach the άMax. data records in a fileέ, and the data sampling 
file will not be generated. 

Â When a new file is generated, the systm will first detect if the filename already exists. If the 
file name does exist, the newly sampled data will be appended to the existing file. 

 

 Click the icon to download the demo project. Please confirm your internet connection 

before downloading the demo project. 

8.4. Synchronizing cMT Viewer data and Saving to External Device or Database 

 
For other series, when displaying the sampled data in Trend Display object, it is necessary to 

select from Real-time mode or History mode and the two modes cannot simultaneously be 

displayed in one object. 

History data in external device Real-time data 

https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Data_Log_Customized_File_Handling_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Data_Log_Customized_File_Handling_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Data_Log_Customized_File_Handling_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Data_Log_Customized_File_Handling_Demo.zip
https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Data_Log_Customized_File_Handling_Demo.zip
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cMT Series allows displaying history data and at the same time updates real-time data in one 

Trend Display or History Data Display object. The data saved in the external device can be 

updated. 

The rule of synchronizing the data saved in the external device: 

1. When the sampled data reaches 10000 records, HMI will automatically save data to the 

external device and deletes the earliest 1000 records in HMI. 

2. If the external device is removed from HMI, and inserted back again at the time when the 

sampled data is under 9000 records, the data generated during the time the external 

device is removed is saved in HMI and is not cleared. If the data exceeds 9000 records 

during the time the external device is removed, the earlier data is cleared and cannot be 

synchronized even to insert the external device back to the HMI. 

3. If there already exists sampled data in the external device, the new data is appended 

without overwriting the original data each time in synchronization. 

8.5. Checking History Data of a Specific Date / File on cMT Viewer. 

To check the history data, see the following steps (Use Trend Display object as example). 

1. Tap the  icon in the upper-right corner of the Trend Display object. 

2. The following dialog box appears. 

  
3. Specify the date or the file. 

  

4. Tap [Done] button to finish setting. 
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 Object General Properties 9.
This chapter explains the basic settings of an object. 

 

9.1. Overview ....................................................................................................................... 9-2 

9.2. Selecting PLC and Setting Read/Write Address ............................................................ 9-2 

9.3. Using Shape Library and Picture Library ....................................................................... 9-3 

9.4. Setting Label Text .......................................................................................................... 9-7 

9.5. Adjusting Profile Size .................................................................................................... 9-9 
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9.1. Overview 

The basic steps to create an object: 

1. Selecting the PLC device and setting the read/write address. 

2. Using Shape Library and Picture Library. 

3. Setting label text. 

4. Adjusting profile size. 

This chapter explains the basic settings of an object. 

9.2. Selecting PLC and Setting Read/Write Address 

Most objects read data from PLC devices, so a properly configured PLC address is needed. 

Select the PLC to control at [PLC name] which comes from [System Parameters Settings] » 

[Device List]. 

 

 

Setting Description 

PLC name Select the PLC type. 

Device type Different PLCs have different device types. 

Address Set the read/write address. 

System tag Address tags include [System Tag] and [User-defined Tag]. 

This option allows users to use [System Tag]. [System Tag] 

consists of the preserved addresses by system for 

particular purposes. The address tags include bit registers 

or word registers (LB or LW).  

After selecting [System tag], not only will the [Device type] 

field display the chosen tag, but [Address] field will also 

display the chosen register. 
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Index register Select this check box to use the [Index Register]. 

 For more information about System Tag, see ά22 System Reserved Words and Bitsέ. 

 For more information about Index Register, see ά11 Index Registerέ. 

 For more information about Tag Library, see ά16 Address Tag Libraryέ. 

9.3. Using Shape Library and Picture Library 

In the settings dialog box of certain objects, άShapeέ tab can be found. In this tab, Shape 

Library and Picture Library can be used to add visual effects on objects. Select Shape tab to use 

the libraries when creating an object. 

 

 Picture 9.3.1.

Select [Use picture] and then click [Picture Library] button to open Picture Manager window, 

and select a picture from the window. 
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Setting Description 

Picture 

Library 

Click [Picture Library] button in Picture group box to open 

Picture Manager window. 

Set to 

original 

dimensions 

When this checkbox is selected, EasyBuilder will return the 

picture to its original size to eliminate the redrawing step. 

Duplicate these 

attributes to 

every state 

This button is available only when a system picture is used. 

Clicking this button will duplicate the attributes of the 

current picture to other states. 

 Shape 9.3.2.

Select [Use shape] and then click [Shape Library] button to open Shape Manager window, and 

select a shape from the window. 
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Setting Description 

Inner Select [Display] to show the inner color of the shape, and 

select a color as the inner color by clicking the drop down 

button. 

 

Frame Select [Display] to show the frame color of the shape, and 

select a color as the frame color by clicking the drop down 

button. 

Pattern color Click the drop down button to select a color for the 

interior pattern of the shape. 

Pattern type Click the drop down button to select a pattern. 
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Set to all 

states 

Duplicate the attributes of the current state to other 

states. 

 Shape manager 9.3.3.

In Picture Manager and Shape Manager windows, the currently selected pictue / shape is 

highlighted yellow as shown below.  

 
The information about the selected picture / shape: 

Directory The directory from which EasyBuilder searches for the pictures / shapes. 

Shape5  Name of the shape. 

States: 2 Number of states of the shape. 

Objects: 1 This shape is used by 0 object in the project. 

Inner The state 0 and state 1 of this shape contain only άƛƴƴŜǊέ but not άŦǊŀƳŜΦέ  

 For more information, see ά14 Shape Library and Picture Libraryέ. 
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9.4. Setting Label Text 

 
 

Setting Description 

Use label Select this check box to use labels for the object. 

Use label 

library 
Select this check box to choose a label in Label Library. 

Convert 
labels to 
bitmap 
images 

Select this check box to convert the label text into bitmap 

format. 

Label Library Browse Label Library 

 For more information, see ά15 Label Tag Library 

and Multi Languageέ. 

Font Select a font from the list. EasyBuilder Pro supports 

Windows True-type fonts. 

Color Select the font color. 

Size Select the font size. 
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Align Apart from setting [Align] here, alignment can also be 

done by clicking the following shortcut keys. Multilined 

text is aligned within the label outline instead of aligning 

to the outline of the object.  

                
[Left]            [Center]            [Right] 

   

Blink Specify the way the text blinks. Choose [None] to disable 

this feature or set the blinking interval to [1 second] or 

[0.5 seconds]. 

Italic 
Use Italic font.  

Underline 
Use Underline font.  

Movement Direction 

Set the direction of the marquee effect. The directions 

include: [No movement], [Left], [Right], [Up], [Down]. 

Continuous 

Specify how the marquee effect is displayed. 

If not selecting this check box, the next text appears only 

when the previous text disappears completely.  

 
If selecting this check box, the text will be displayed 

continuously. 

 
Speed 

Adjust the speed of the text movement. 

Content Set the content of the text. If [Label Library] is used, it will 

automatically use the text defined in Label Library. 

Tracking If this check box is selected, when changing the position of 

the text in one state, the text position in the other states 

will also change in accordance. 

Duplicate this 
label to other 
state 

Duplicate the current text to the other states. 
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Note 

Â When Text/Comment object is used with Comment enabled, the text used as comment 

will not appear on HMI. 

Â Clicking shortcut keys  can align multilined label text. To align label text, please 

select the dotted outline of the label (red). When objectΩs outline (blue) is selected, 

clicking the shortcut keys can only move the entire label to the left, center, or right edge 

of the object without aligning the label text lines. 

   

Â When the texts of the fonts used in the editing window and on the HMI screen are not 

properly aligned vertically, it is possible to correct it with the FontRules.xml file in 

ά҈ŀǇǇŘŀǘŀ҈\Weintek\9ŀǎȅ.ǳƛƭŘŜǊέ ŦƻƭŘŜǊΦ  

By adding the names of the fonts in question into the FontRules.xml file, their vertical 

metrics can be adjusted in advance to avoid the misalignment problem. 

 

 

9.5. Adjusting Profile Size 

When an object is created and placed in the editing screen, double click it and select the 

[Profile] tab to adjust the position and size of the object. 
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Setting Description 

Position Pinned 

When this check box is selected, the position and the size 

of the object cannot be changed. 

[X] and [Y] 

The coordinates of the position of the object in the editing 

screen. 

Size Adjust the [width] and [height] of the object. 
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 User Password and Object 10.

Security 
This chapter discusses the protection for operations provided by setting up user passwords and 

security classes. 

 

10.1. Overview ..................................................................................................................... 10-2 

10.2. User Password and Operable Object Classes ............................................................. 10-2 

10.3. Enhanced Security Mode and Control Address .......................................................... 10-4 

10.4. Enhanced Security Mode Usage ................................................................................. 10-8 

10.5. Object Security Settings ............................................................................................ 10-19 

10.6. Example of Object Security Settings ......................................................................... 10-27 

10.7. Protecting Password Settings from Unauthorized Editing ....................................... 10-30 

10.8. Bulk Changing of Security Settings of Multiple Objects ........................................... 10-31 
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10.1. Overview 

This chapter discusses the protection for operations provided by setting up user passwords and 

security classes. Authentication modes are: 

 ̧ General Mode 

 ̧ Enhanced Security Mode 

 

In addition, cMT series allows the use of LDAP protocols for user authentication. 

 

To set up the protection system, please: 

1. Set user password and operable classes. 

2. Set object class for objects. 

An object belongs only to one security class. Setting the object Ŏƭŀǎǎ ǘƻ άNoneέ means any user 

can operate this object. 

10.2. User Password and Operable Object Classes 

The security parameters can be found in [System Parameter Settings] » [Security]. 

 General Mode 10.2.1.

Up to 12 sets of user and password are available. A password should be one non-negative 

integer. There are six security classes: A to F. 

Once the password is entered, the objects that the user can operate are classified. As shown 

belowΣ ά¦ǎŜǊ мέ can only operate objects with class A or class C. 

Note 

Â General Mode is not used for cMT Series. 
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 Click the icon to download the demo project. Please confirm your internet connection 

before downloading the demo project. 

 Enhanced Security Mode 10.2.2.

Up to 11 users can be set here. In addition, [Administrator] setting is provided. Administrator 

has all privileges and can operate all object classes. User passwords must be alphanumeric 

characters and each user can have up to 12 operable classes: A to L. (Up to 127 users can be 

set in Administrator Tools. Please see άмлΦп EnhŀƴŎŜŘ {ŜŎǳǊƛǘȅ aƻŘŜ ¦ǎŀƎŜέ for more details.) 

 

Enhanced Security Mode provides a [Control address] for users to manage the accounts 

directly on HMI. tƭŜŀǎŜ ǎŜŜ άмлΦо 9ƴƘŀƴŎŜŘ {ŜŎǳǊƛǘȅ aƻŘŜ ŀƴŘ /ƻƴǘǊƻƭ !ŘŘǊŜǎǎέ for more 

details. Alternatively, use USB Security Key to log in automatically. Insert the USB disk in which 

the key is saved to log in. Please see 10.4.3 [ƻƎƛƴ κ [ƻƎƻǳǘ !ǳǘƻƳŀǘƛŎŀƭƭȅ ǿƛǘƘ ¦{. {ŜŎǳǊƛǘȅ YŜȅέ 

for more details. 

  

https://dl.weintek.com/public/MT8000/Project/Part_Sample/Security.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Security.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Security.zip
https://dl.weintek.com/public/MT8000/Project/Part_Sample/Security.zip













































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































